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Preface

Notice

The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.

©May 2017

Trademarks
Intel, Pentium and Intel Core are trademarks/registered trademarks of Intel Corporation.
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R&TTE Directive
Thisdeviceisin compliance with the essential requirements and other relevant provisions of the R& TTE Direc-
tive 1999/5/EC.

Thisdevice will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, Lux-
embourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland,
United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slov-
enia.

ErP Off Mode Power Consumption Statement:
Thefigures below note the power consumption of thiscomputer in compliance with European Commission (EC)
regulations on power consumption in off mode:

« Off Mode <0.5W
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CE Marking

This device has been tested to and conforms to the regulatory requirements of the European Union and has at-
tained CE Marking. The CE Mark is a conformity marking consisting of the letters“CE”. The CE Mark applies
to products regulated by certain European health, safety and environmental protection legislation. The CE Mark

is obligatory for products it applies to: the manufacturer affixes the marking in order to be allowed to sell his
product in the European market.

This product conforms to the essential requirements of the R& TTE directive 1999/5/EC in order to attain CE
Marking. A notified body has determined that this device has properly demonstrated that the requirements of the
directive have been met and hasissued afavorable certificate of expert opinion. As such the device will bear the
notified body number 0560 after the CE mark.

The CE Marking is not a quality mark. Foremost, it refers to the safety rather than to the quality of a product.
Secondly, CE Marking is mandatory for the product it applies to, whereas most quality markings are voluntary.
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FCC Statement

(Federal Communications Commission)

Y ou are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limitsfor aClass B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonabl e protection against harmful interferencein
aresidential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, thereisno guarantee that interference will not occur in aparticular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

« Connect the equipment into an outlet on acircuit different from that to which the receiver is connected.
» Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
And

2. This device must accept any interference, including interference that may cause undesired operation of the
device.
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FCC RF Radiation Exposure Statement:
1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator

and your body.

N2
2

Warning

Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the

equipment.
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IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.

4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may
explode. Check with local codes for possible special disposal instructions.

5. This product is intended to be supplied by a Listed Power Unit as follows:

AC Input of 100 - 240V, 50 - 60Hz, DC Qutput of 19.5V, 6.15A (120 Weatts) minimum AC/DC Adapter.

Vi



Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions.

1.

Preface

Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

Do not expose the computer
to any shock or vibration.

surface.

Do not placeit on an unstable

Do not place anything heavy
on the computer.

Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-

aged.

Do not expose it to excessive
heat or direct sunlight.

Do not leaveit in a place
where foreign matter or mois-
ture may affect the system.

Don't use or store the com-
puter in a humid environment.

Do not place the computer on
any surfacethat will block the
Vents/Fan Intakes.

Vi
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Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other
strong magnetic fields. These can hinder proper performance and damage your data.

Follow the proper working procedures for the computer. Shut the computer down properly and don'’t forget

to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

Do not turn off the power
until you properly shut down
all programs.

Do not turn off any peripheral
devices when the computer is
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance
on your computer.

VIiI

Take care when using peripheral devices.

Use only approved brands of
peripherals.

Unplug the power cord before
attaching peripheral devices.
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Servicing

Do not attempt to service the computer yourself. Doing so may violate your warranty and may expose you and
the computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from
the power supply. Then refer servicing to qualified service personnel under any of the following conditions:

»  When the power cord or AC/DC adapter is damaged or frayed.

 If the computer has been exposed to rain or other liquids.

* If the computer does not work normally when you follow the operating instructions.

* If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
* If thereisan unusua odor, heat or smoke coming from your computer.

\ A/
LS
Bottom Cover Removal Warning

Users should not remove any cover(s) and /or screw(s) for the purposes of device upgrade as this may violate the terms of
your warranty. If you need to replace/remove the hard disk/RAM/optical device etc., for any reason, please contact your dis-
tributor/supplier for further information.

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and

screw(s) before restoring power to the system.
Also note the following when the cover is removed:

e Hazardous moving parts.
* Keep away from moving fan blades.
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Power Safety
The computer has specific power requirements:

\ A/
2R
Power Safety Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines and power
cord).

You must also remove
your battery in order to
prevent accidentally
turning the machine on.
Before removing the
battery disconnect the
AC/DC adapter from
the computer.

Only use a power adapter approved for use with this computer.

Your AC/DC adapter may be designed for international travel but it still requires a
steady, uninterrupted power supply. If you are unsure of your local power specifica-
tions, consult your service representative or local power company.

The power adapter may have either a 2-prong or a 3-prong grounded plug. The third
prong isan important safety feature; do not defeat its purpose. If you do not have access
to acompatible outlet, have aqualified electrician install one.

When you want to unplug the power cord, be sure to disconnect it by the plug head, not
by itswire.

Make sure the socket and any extension cord(s) you use can support the total current
load of all the connected devices.

Before cleaning the computer, make sure it is disconnected from any external power
supplies (i.e. AC/DC adapter or car adapter).

Do not plug in the power
cord if you are wet.

Do not use the power cord if | Do not place heavy objects
itis broken. on the power cord.
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Polymer/Lithium-lon Battery Precautions
Note the following information which is specific to Polymer/Lithium-lon batteries only, and where applicable,
this overrides the general battery precaution information overleaf.

» Polymer/Lithium-lon batteries may experience a dight expansion or swelling, however thisis part of the battery’s
safety mechanism and is not a cause for concern.

e Use proper handling procedures when using Polymer/Lithium-1on batteries. Do not use Polymer/Lithium-lon batteries
in high ambient temperature environments, and do not store unused batteries for extended periods.

» If you are working in areas of low temperature use the AC/DC adapter to power the computer.

See aso the general battery precautionary information overleaf for further information.

Xl
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General Battery Precautions

» Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.

» Do not remove any batteries from the computer while it is powered on.

» Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even
if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly
resultinfire.

» If you do not use the battery for an extended period, then remove the battery from the computer for storage.

» Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.

» Donot try to repair abattery pack. Refer any battery pack repair or replacement to your service representative or qual-
ified service personnel.

» Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries
may explode or leak if exposed to fire, or improperly handled or discarded.

» Keep the battery away from metal appliances.

» Affix tape to the battery contacts before disposing of the battery.

» Do not touch the battery contacts with your hands or metal objects.

\ A/
2R
Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,

under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.

Xl
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Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Cleaning Instructions

(For Computer Models Supplied with Light Blue Cleaning Cloth)
Some computer modelsin this series come supplied with alight blue cleaning cloth. To clean the computer case
with this cloth follow the instructions below:

Power off the computer and peripherals.

Disconnect the AC/DC adapter from the computer.

Use a little water to dampen the cloth slightly.

Clean the computer case with the cloth.

Dry the computer with a dry cloth, or allow it time to dry before turning on.
Reconnect the AC/DC adapter and turn the computer on.

ok wnpE

X1l
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Travel Considerations
Asyou get ready for your trip, run through this list to make sure the system is ready to go:

Check that the battery pack and any spares are fully charged.

Power off the computer and peripherals.

Close the display panel and make sure it's latched.

Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.

The AC/DC adapter uses voltages from 100 to 240 volts so you won't need a second voltage adapter. However,
check with your travel agent to see if you need any socket adapters.

Put the notebook in its carrying bag and secure it with the bag’s straps.

If you're taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters
and/or cables.

8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both
hardware and software. Make sure your “papers” are handy.

SN
ALK

Power Off Before Traveling

agprwbNPE

N o

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the Vents/Fan Intakes to be blocked. To prevent your computer
from overheating make sure nothing blocks the Vent/Fan Intakes while the computer is in use.

XV
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On the Road

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these pointsin mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’'t check it with normal luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Bewar e of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
Theserestrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power whereyou can - If an electrical outlet isavailable, usethe AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from acold to awarm location, water vapor can condense inside the computer.
Wait afew minutes before turning it on so that any moisture can evaporate.

XV
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Developing Good Work Habits

Developing good work habitsisimportant if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

¢ Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the
level of your elbow. Keep your forearms, wrists, and hands in arelaxed position.

*  Your knees should be slightly higher than your hips. Place your feet flat on the floor or on
afootrest if necessary.

¢ Useachair with aback and adjust it to support your lower back comfortably.

e St straight so that your knees, hips and elbows form approximately 90-degree angles
when you are working.

e Takeperiodic breaksif you are using the computer for long periods of time.

Remember to:
e Alter your posture frequently.
¢ Stretch and exercise your body several times a day.
¢ Take periodic breaks when you work at the computer for long periods of time. Frequent
and short breaks are better than fewer and longer breaks.

XVI
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Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatiguein your neck and
shoulders.

Position the display to avoid glare or reflections from overhead lighting or outside sources of light.

Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
Position the display directly in front of you at a comfortable viewing distance.

Adjust the display-viewing angle to find the best position.

LCD Screen Care

To prevent image per sistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

Set the Windows Power Plansto turn the screen off after afew minutes of screenidle time.

Use arotating, moving or blank screen saver (this prevents an image from being displayed too long).
Rotate desktop background images every few days.

Turn the monitor off when the system isnot in use.

LCD Electro-Plated Logos

Note that in computers featuring araised LCD electro-plated logo, the logo is covered by a protective adhesive.
Due to general wear and tear, this adhesive may deteriorate over time and the exposed logo may develop sharp
edges. Be careful when handling the computer in this case, and avoid touching the raised LCD electro-plated
logo. Avoid placing any other items in the carrying bag which may rub against the top of the computer during
transport. If any such wear and tear develops contact your distributor/supplier.

XVII
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Quick Start Guide

Chapter 1. Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

» Chapter 2 A guideto using some of the main features of the computer e.g. the stor age devices (hard disk and
card reader), TouchPad & M ouse and Audio Features.

e Chapter 3 The computer’s power management options.

e Chapter 4 Theinstalation of the driversand utilities essential to the operation or improvement of some of the
computer’s subsystems.

e Chapter 5  An outline of the computer’s built-in software or BIOS (Basic Input Output System).

* Chapter 6 A quick guide to the computer’s PC Camera, WirelessL AN, Fingerprint, Bluetooth & WLAN
Combo, Sound Blaster Audio and I ntel modules (some of which may be optional depending on
your purchase configuration).

e Chapter 7 A troubleshooting guide.

« Appendix A Definitions of the interface, ports/jackswhich allow your computer to communicate with external
devices.

» Appendix B Information on the Control Center. and Flexikey® Application.

» Appendix C Information on the Video driver controls.

» Appendix D The computer’s specification.

. |
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Advanced Users

If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “Drivers & Utilities” on page4 - 1 and “BIOS Utilities’ on page5 - 1 in the User’'s Manual. You
may also find the notes marked with a /# of interest to you.

Beginners and Not-So-Advanced Users

4 If you are new to computers (or do not have an advanced knowledge of them) then
Notes the information contained in this Quick Start Guide should be enough to get you up
. and running. Eventually you should try to look through all the documentation (more
Check the light colored detailed descriptions of the functions, setup and system controls are covered in the

boxes with the mark '
above to find detailed remainder of the User’s Manual), but do not worry if you do not understand every-
information about the || thing the first time. Keep this manual nearby and refer to it to learn as you go. You
computer’s features. may find it useful to refer to the notes marked with a .~ as indicated in the margin.
For amore detailed description of any of the interface ports and jacks see “ I nterface

(Ports & Jacks)” on pageA - 1.

Warning Boxes

No matter what your level please pay careful attention to the warning and safety information indicated by the
2 symbol. Also please note the safety and handling instructions as indicated in the Preface.

1-2 Overview
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Not Included

Operating Systems (e.g. Windows 10) and applications (e.g. word processing, spreadsheet and database pro-
grams) have their own manuals, so please consult the appropriate manuals.

4

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the appropriate drivers. Drivers are programs which act as an interface between the computer and a hardware component
e.g. a wireless network module. It is very important that you install the drivers in the order listed in Table 4 - 1, on page 4
- 4. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If your
system hasn’t been properly configured (your service representative may have already done that for you), refer to “Drivers
& Utilities” on page 4 - 1 for installation instructions.

Ports and Jacks

See “Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your computer to com-
municate with external devices, connect to the internet etc.

Overview 1 -3
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System Software

Y our computer may aready come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for adifferent system, you will find the Windows 10 (64-bit) operating system
IS supported.

4

Windows OS

Note that the information included on the following pages is for Windows 10 only.

In order to run Windows 10 (64-bit) your computer requires a minimum 4GB of system memory (RAM).

. |
1 -4 Overview
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System Startup

1. Remove all packing materials, and place the computer on a stable surface, and securely attach any peripherals
you want to use with the notebook (e.g. keyboard and mouse) to their ports.

2. Attach the AC/DC adapter to the DC-In jack at the rear of the computer, then plug the AC power cord into an
outlet, and connect the AC power cord to the AC/DC adapter (make sure you use the adapter when first
setting up the computer, as to safeguard the computer during shipping, the battery will be locked to not power
the system until first connected to the AC/DC adapter).

3. Use one hand to raise the lid/LCD to a comfortable viewing angle (it is preferable not to exceed 135 degrees); use
the other hand to support the base of the computer (Note: Never lift the computer by the lid/LCD).

4. Press the power button on the top of the computer for about 2 - 3 seconds to turn the computer “on” (note that
the power LED on the front of the computer will turn from orange to green when the computer powers on).

4

Shutdown

Note that you should
always shut your com-
puter down by choos-
135° ing the Shut Down
command in  Win-
dows. This will help
prevent hard disk or
system problems.

Figure 1 - 1 - Computer with AC/DC Adapter Plugged-In/Opening the Lid/LCD

L_________________________________________________________________________________________________________________________________________________|
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Figure1-2 LCD Panel Open
LCD Panel Open
©0 o (3 s

1. Built-In PC Camera Wireless Device

2. PC Camera LED Operation Aboard

3. Built-In Array Aircraft
Microphone

4. LCD 9 The use of any portable elec-

tronic transmission devices

5. Speakers (e.9. WLAN, Bluetooth or

6. Power Button 3G/4G) aboard aircraft is

7. lluminated LED usually prohibited. Make
Keyboard sure any wireless modules

8. TouchPad & Buttons are OFF (i.e. the systemis in

Airplane Mode) if you are
using the computer aboard

6 e aircraft.

@ Use Fn + F11 Airplane
Mode key combination to
toggle Airplane Mode On/
e Off, and check the LED indi-
@ cator for the power status.

Note that the Touchpad/

Clickpad and Buttons has a

valid operational area indi-

cated within the dotted lines (8]
above.

1 -6 LCD Panel Open



LED Indicators

The LED indicators display helpful information about the current status of the computer.

Quick Start Guide

Blinking Orange

Power Status

Icon Color Description Icon | Color Description
Orange The Battery is Charging Green Hard Disk Activity
The Battery has Reached Critically Low Green Airplane Mode is ON (the WLAN,
+ Bluetooth & 3G/4G Modules are OFF)

The Battery is Fully Charged

Green
Orange AC/DC Power is Plugged In
Blinking The Powered USB Port is On
Orange* (see Figure 1 -7 on page 1 - 15)
Green The Computer is On
Blinking Green The Computer is in Sleep Mode
Table 1-1 - LED Indicators

.|
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4

Other Keyboards

If your keyboard is dam-
aged or you just want to
make a change, you can
use any standard USB
keyboard. The system will
detect and enable it auto-
matically. However spe-
cial  functions/hot-keys
unique to the system’s
regular keyboard may not
work.

Scr Lk

Hold down the Fn Key
and Scr Lk to enable
scroll lock/number lock,
and check the LED indi-
cator for status.

llluminated LED Keyboard

Theilluminated keyboard has an embedded numerical keypad for easy numeric data
input, and features function keysto allow you to change operational featuresinstant-
ly. See Table 1 - 3, on page 1 - 13 for full function key combination details.

| Function Keys | | |

|:| Play/Pause Key Scr Lk Key
Num Lk Key
Numerical
Game Control Keys Menu/Application Key Keypad

Windows Logo Key

Figure 1 - 3 - llluminated LED Keyboard

4

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLKk is on.

1 -8 llluminated LED Keyboard
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Keyboard Shortcuts

The following Windows Logo Key (Winkey) keyboard shortcuts are useful for navi- 4
gation/operation in Windows 10. Windows Logo

Keyboard Shortcut
Windows Logo & T

Key + — Description Use the Windows logo
key 3@ + D key com-
Tap Winkey Toggle the Start menu bination to switch be-
- tween the Start screen
A Open the Action Center and Windows Desktop.

B Select the Taskbar Notification Area Menu/Application

C Launch Cortana (in listening mode) Keyboard Shortcut
D Toggle the Desktop When the Desktop app
- - iS running you can use
E Launch File Explorer (Quick Access tab) the Menu/Application
+ Number (1, 2, etc) Launch an application from the taskbar (numbered from left to right) key [E] on the key-
board to display the
Table 1 - 2 - Keyboard Shortcuts context menu as per a

mouse right-click.

llluminated LED Keyboard 1 -9
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Control Center

When in the Windows Desktop application (not in the Start screen) press the Fn + Esc key combination, or
double-click theicon  inthenactification area of thetaskbar to togglethe Control Center on/off. The Con-
trol Center gives quick access to frequently used controls and enables you to quickly turn the camera/Touch
Pad on/off (see Appendix B for full details).

4

Control Center Access

To run the
Control Cen-
ter press the

Fn + Esc key
combination,
or double-

click the icon

in the noti-
fication area
of the taskbar.

Close the Control Center by clicking
the close icon in the top right of the
panel (move the cursor onto the top
right corner of the panel to highlight it).

Figure 1 - 4 - Control Center

1-10 Control Center
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Flexikey® Application

The Flexikey® application isaquick hotkey configuration application, which allowsyou to assign asinglekey
to launch multiple key combinations, or to launch programs and applications, to create text macr os and to
disable certain keys. The application can also be used to configure the mouse buttons to create hotkeys for
gaming etc. All the configuration settings are retained under (up to12) profiles to which the settings are applied.
Click Flexikey® in the Gaming section of the Control Center, or the click the icon in the notification
area of the taskbar, to launch the application (see Appendix B for full details).

Flexikey® Enabled

Flexikey® Disabled

Figure 1 - 5 - Flexikey® Hotkey Application

.|
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Flexikey® Application Features:
For full details see “ Flexikey® Application” on page B - 8.

« EXPRESSKEY - Thisfeature allows you to configure asingle key (or mouse click) to send multiple key
combinations, or to create more useful shortcut keys Thisis useful in gaming or when using applications
which have a complex set of keyboard shortcuts.

* LAUNCH APP - Thissimply assigns single keys (or mouse clicks) to launch any program’s or applica-
tion’s executable file.

« EXPRESSTEXT - With thisyou can assign single keys (or mouse clicks) to send commonly used strings
of text.

* DISABLE - Usethisfunction to disable any keyboard keys or mouse buttons.
» STATISTICS - Use thisto quickly record keysin use in any application, and to disable unused keys.

.|
1-12 Flexikey® Application



Function Keys & Visual Indicators
The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down.

Quick Start Guide

Keys Function/Visual Indicators Keys Function/Visual Indicators
Fan Control
Fn + Toggle Automatic / Fn + Control Center Toggle (see over)
Full Power
Fn + Play/Pause (in Audio/Video Programs) Fn+ Display Toggle
Fn + Touchpad Toggle Fn + Brightness Decrease/Increase
Fn+ Turn LCD Backlight Off En + PC Camera
(Press a key to or use Touchpad to turn on) Power Toggle
Airplane
F Fn +
n+ Mute Toggle Mode Toggle
Fn + Keyboard LED Toggle Fn + Sleep Toggle

Fn +

Volume Decrease/Increase

Fn + Power Button

Powered USB 3.0 Port Power Toggle

Table 1 - 3 - Function Keys & Visual Indicators

Fn + Backspace

Flexikey® Enable/Disable

Flexikey® Application 1 - 13
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Figure 1-6
Front & Rear Views

1. LED Power Indica-
tors

2. Vent/Fan Intake

3. DC-In Jack

USB Ports

Note that the connections to
the USB ports only fit one
way, do not force them.

Overheating

To prevent your computer
from overheating make sure
nothing blocks the vent(s)/
fan intake(s) while the com-
puter is in use.

Front & Rear Views
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Right View

Multi-in-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / RSMMC
SD (Secure Digital) / Mini SD / SDHC / SDXC

Powered USB 3.0 Port (USB 3.1 Gen 1)

Note that the USB 3.0 port is not operational under DOS and does not support wake on
USB. The powered USB 3.0 e port can supply power (for charging devices only, not
for operating devices) when the system is off but still powered by the AC/DC adapter
plugged into a working outlet, or powered by the battery with a capacity level above 20%
(this may not work with certain devices - see page 7 - 12). Toggle power to this port by using
Fn + power button.

Quick Start Guide

Figure1-7
Right View

. SIM Card Reader

(for 3G/4G USIM
Cards - see over)
Multi-in-1 Card
Reader

1 * Type A Powered
USB 3.0 Port (USB
3.1Genl)

1*Type AUSB 3.0
Port (USB 3.1 Gen 1)
RJ-45 LAN Jack

. Security Lock Slot

2MN\L
/Q\

USB Ports

Note that the connections to
the USB ports only fit one
way, do not force them.

Right View 1 - 15



Quick Start Guide

3G/4G Module USIM Card Installation
L& Insert the USIM card @ asillustrated below (pay careful attention to the orientation
LSV e-sheil=h-c f| of the card asthe gold contact side of the card should face downwards) until it clicks
tion fully into position. To gect the card simply pressit until it gjects, but do not attempt
to gect the card while connected to a 3G/4G network (see below).

Note that the USIM

card’s readable side
(with the gold-colored
contacts) should face
downwards as illustrat-

ed. 9

Figure 1-8 ﬁ
USIM Card Insertion —
USIM Card Ejection

Simply press on the USIM card to eject it, however do not do this while a connection is in
progress.

If you do eject the card while a 3G/4G connection is ongoing, you will need to shut down
the system, reinsert the USIM card, restart the system and then reestablish the 3G/4G con-
nection.

If you wish to change USIM cards then you will need to shut the system down, reinsert the
USIM card, restart the system and then reestablish the 3G/4G connection.

1-16 Right View
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Left VI eW Figure 1-9
Left View
1. Mini Display Port
(1.4 Ready) 1
o 9 e e 6 @ e @ 2. Mini Display Port
1.2)2
4 3. HDMI-Out Port

S 4. 1*USB 3.0 Port
HDMI Port / Mini Display Port (USB3.1 Gen 1)

Note that the HDMI Port and Mini Display ports support video and audio signals to attached 5. 1* Type C USB
external displays (see “HDMI Audio Configuration” on page C - 7). 3.0 Port (USB3.1
Note that Sound Blaster X-Fi MB5 audio will be disabled when you are connecting to an Gen 1)
external display through an HDMI or Mini Display port connection. OR

USB Ports 1*Type C USB

3.1 (Gen 2) Port
The USB 3.0 35> ports capable of 5Gbps (SuperSpeed) are classified as USB 3.1 Gen 1. (Factory Option)
There are three or four (factory option dependent) USB 3.0 (USB 3.1 Gen 1) 50%’ ports on Microphone Jack
this computer model (including the powered USB 3.0 port). One new USB 3.1 Gen 2 port Headphone Jack
(Type C) 55 , capable of 10Gbps (SuperSpeed+) is available as a factory option. Note the 8. S/PDIE-Out Jack
Type C port is the smaller sized USB port.

No

Left View 1 - 17
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4

Mini Display Ports

Depending on the port being connected to, external displays can be configured using either
the Intel HD Graphics control panel, Project menu (press the Windows logo key == on
your keyboard and the P key), Display Settings or NVIDIA Control Panel.

Mini Display Port 1 0; If you wish to configure an external display connected to Mini Dis-
play Port 1 you must use Project Menu, Display Settings in Windows (see Figure C - 2
on page C - 6) or the NVIDIA Control Panel (see “NVIDIA Control Panel” on page C -
31) to adjust the display configuration.

Mini Display Port 2 @: If you wish to configure an external display connected to Mini Dis-
play Port 2 you must use the Intel HD Graphics control panel (see “Intel® HD Graphics
Control Panel” on page C - 13) menu to control the display configuration.

See Appendix C for full information on external display configuration.

Figure 1 - 10 - Left Side View
(Mini Display Ports Highlighted)
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Bottom View Figure 1- 11

Bottom View

1. Fan Outlet/Intake

2§

Overheating

To prevent your computer
from overheating make sure
nothing blocks the vent(s)/
fan intake(s) while the com-
puter is in use.

Bottom Cover Removal
Warning

Do not remove any cover(s)
and /or screw(s) for the pur-
poses of device upgrade as
this may violate the terms of
/ your warranty.
If you need to replace/re-
Battery Information move the hard disk/RAM/
optical device etc., for any
Always completely discharge, then fully charge, a new battery before using it. Completely reason, please contact your
discharge and charge the battery at least once every 30 days or after about 20 partial dis- distributor/supplier for fur-
charges. See “Battery Information” on page 3 - 17 for full instructions. ther information.

Bottom View 1 - 19
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Windows 10 Start Menu

Most of the apps, control panels, utilities and programs within Windows 10 can be accessed from the Start

Menu by clicking theicon gg in the taskbar in the lower |eft corner of the screen (or by pressing the Windows
Logo Key 2@ on the keyboard).

Figure 1 - 12 - Windows Start Menu

1-20 Windows 10 Start Menu
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Right-Clicking the Windows Logo In Start Menu

Right-click the Start Menu gg icon (or use the Windows Logo Key g@ + X key combination) to bring up an
advanced Context M enu of useful features such as Control Panel, Programs and Features, Power Options, Task
Manager, Search, File Explorer, Command Prompt, Device Manager and Network Connections etc.

Right-Click Icon

Figure 1 - 13 - Right-Click Windows Logo in Start Menu

Windows 10 Start Menu 1 - 21
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Start Menu Apps & Tiles

The Windows 10 Start Menu will contain a number of apps, and many more will be installed as you add more
applications etc. Not al of these apps can fit on the screen so may need click and drag the handles at the edge of
the screen to expand the menu in order to view all the apps (you can use the scroll bar to move up and down the
screen).

Figure 1 - 14 - Expanding the Start Menu

. |
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Pining/Unpinning Apps & Programs to/from the Start Menu

To make things easy to find you can add and remove tiles for apps and programs to the Start Menu. Right-Click
on aprogram’sicon and select Pin to Start from the drop-down menu. To remove an app or program from the
Start Menu right-click the icon and select Unpin from Start. Y ou can use the same method to pin apps/pro-
gramsto/from the taskbar (select pin to taskbar/unpin this program from the taskbar).

Figure 1 - 15 - Pin to Start/Unpin from Start

. |
Windows 10 Start Menu 1 - 23
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Windows 10 Control Panel

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel can be accessed in a number of waysin Windows 10.

* Right-click the Start Menuicon
2a inthetaskbar in the lower |left
corner of the screen and select
Control Panel from the menu.

* Pressthe Windowslogo key s
on your keyboard and X to bring
up the context menu, and then
press P to bring up the Control
Panel.

» Type Control Panel into the
Search box in the taskbar and
click on the icon when it pops up.

Figure 1 - 16 - Windows 10 Control Panel Access

. |
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Settings

The Settingsitem in the Start Menu (and also as an App) gives you quick access to anumber of system settings
control panels allowing you to adjust settings for System, Devices, Network & internet, Personalization, Ac-
counts, Time & language, Ease of Access, Privacy and Update & security.

Figure 1 - 17 - Settings

. |
Windows 10 Control Panel 1 - 25
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Windows 10 Taskbar

In many instances throughout this manual you will see an instruction to access the notification ar ea of the task-
bar. The notification area of the taskbar in the bottom right of the screen. Some of the Control Panels and appli-
cations referred to throughout the course of this manual can be accessed from here.

Taskbar

Taskbar - Pinned Programs and Apps Notification Area
Figure 1 - 18 - Taskbar

Y ou can pin/unpin apps to/from the taskbar in much the same way as you can to the Start screen (see “ Pining/
Unpinning Apps & Programs to/from the Start Menu” on page 1 - 23).

1-26 Windows 10 Control Panel
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Video Features

Y ou can switch display devices, and configure display options, from the Display Settings control panel. In Win-
dows 10 it is possible to quickly configure external displays from the Project menu (press the Windows logo
key =@ on your keyboard and the P key).

Microsoft Hybrid Graphics

Y our computer will feature Microsoft Hybrid Graphics switchable graphics technology. This seamless tech-
nology is designed to get best performance from the graphics system while allowing longer battery life, without
having to manually change settings. The computer’s operating system (and some applications) will automati-
cally switch between the integrated UMA (Unified Memory Architecture) GPU (iGPU) and the discrete GPU
(dGPU) when required by the applicationsin use. This switch is seamless to the user.

The basic video features for this computer can be configured using the Intel® HD Graphics Control Panel.
Further video configuration is avail able through the NVIDA control panel (see theinformation on the following
pages and Appendix C).

4

Intel/NVIDIA Video Driver Controls

More detailed video controls are provided by the Intel/NVIDIA Control Panel (for more detailed information see Appendix
C). You can also access the control panel by right-clicking the desktop and selecting Graphics Properties/NVIDIA Con-
trol Panel.

Video Features 1 - 27
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To Configure Displays Using Project

1. Attach your display to the appropriate port, and turn it on.

2. Pressthe g@ + P key combination.

3. Click on any one of the options from the menu to select PC screen only, Duplicate, Extend or Second
screen only.

4. You can click Connect to a wireless display at the bottom of the Project screen and follow the steps to
connect to any wireless enabled display.

4

Mini Display Ports
Depending on the port being connected to, external displays can be configured using either

the Intel HD Graphics control panel, Project menu (press the Windows logo key == on
your keyboard and the P key), Display Settings or NVIDIA Control Panel.

Mini Display Port 1; If you wish to configure an external display connected to Mini Display
Port 1 you must use Project Menu, Display Settings in Windows (see Figure C - 2 on
page C - 6) or the NVIDIA Control Panel (see “NVIDIA Control Panel” on page C - 31)
to adjust the display configuration.

Mini Display Port 2: If you wish to configure an external display connected to Mini Display
Port 2 you must use the Intel HD Graphics control panel menu to control the display con-
figuration.

Figure 1 - 19 - Project (Devices)

. |
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To access the Display Settings:

1. You can quickly adjust the display by right-clicking the desktop and selecting Display Settings @ (Figure 1 -
20).

2. Adjust the settings using the sliders in the menu or click Advanced display settings @ (Figure 1 - 20) to
change resolution.

3. Click Apply to save any changes made to resolution.

2 [ —

Figure 1 - 20 - Display Settings
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To access the I ntel (R) HD Graphics Control Panel:
1. Right-click the desktop and select Intel(R) Graphics Settings from the menu.
OR

2. Click the icon in the notification area of the Desktop taskbar and select Intel(R) Graphics Settings from the
menu.

Figure 1 - 21 - Intel® HD Graphics Control Panel
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To accessthe NVIDIA Control Panel:
1. Right-click the desktop and select NVIDIA Control Panel @ (Figure 1 - 22).
OR

2. Double-click the icon @® (Figure 1 - 22) in the Windows control panel.

e

Figure 1 - 22 - NVIDIA Control Panel
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Power Options

Power Options (Hardware and Sound) can be accessed from the Control Panel. The Power button item in
Start Menu (or the context menu) may be used to Shut down or Restart (you can aso add Hiber nate/Sleep to
the menu - see page 1 - 33). To fully control all the power options (including Hibernate mode) go to the Power
Options control panel and configure the power button, sleep button and lid to perform the function selected.

Using the Power Button

1. Go to the Start Menu.

2. Click the Power button

3. Select the power state required
from the menu.

Figure 1 - 23 - Shut Down/Restart

.|
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Y ou can also use the context menu (right-click the Start Menu gg icon or pressthe Windows logo gg + X key
combination) to Sign out, Sleep, Hibernate, Shut down, and Restart.

4

Adding Hibernate/Sleep to the Power Men

1. Go tothe Power Options (Hardware and Sound)
control panel.

2. Click Choose what the power buttons do.

3. Click “Change settings that are currently
unavailable” By Change settings that are currently unavailable .

4. Click to put a check in the Hibernate/Sleep box
under Shutdown settings.

5. Click Save Changes and close the control panel.

Figure 1 - 24 - Context Menu Shut Down or sign out

Ctrl + Alt + Delete Key Combination

You can usethe CTRL + ALT + DEL key combination to bring up a full-screen displaying L ock, Sign out,
Changeapassword, Task Manager and Switch User. If you click the Power iconin the lower right corner of
the screen a power management option menu appears to display Sleep, Hibernate, Shut down, and Restart.

.|
Power Options 1 - 33



Quick Start Guide

Minimum Screen Resolution Settings

1. Windows 10 has minimum screen resolution requirements.

2. Right-click a blank area of the Desktop and select Screen Resolution (or go to the Display control panel).
3. Adjust the Resolution to make sure that it is at least 1024 * 768, although preferably 1366 * 768 or above.

Figure 1 - 25 - Screen Resolution

.|
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Chapter 2. Storage Devices, Mouse, & Audio

Overview

Read this chapter to learn more about the following main features and components
of the computer:

Hard Disk Drive/Solid State Drive
Multi-in-1 Card Reader

Audio Features

Touchpad and Buttons/Mouse

. |
Overview 2 - 1
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e Hard Disk Drive/Solid State Drive

T e — The hard disk drive (HDD) and/or solid state drive (SSD) is used to store your data
Removal Warning in the computer. The hard disk can be taken out to accommodate other serial (SATA)
hard disk drives (see “ Storage” on page D - 2 for specification information), how-
S L DN ey (0 ill need to contact your distributor/supplier to do this in order to avoid
O e e ) everyouwill n o contact your distributor/supplier to do this in order to avoi
G e el e- @ violating the terms of your warranty.

upgrade as this may vio-
late the terms of your
warranty.

If you need to replace/
remove the hard disk for
any reason, please con-
tact your distributor/sup-
plier for further
information.

2 - 2 Hard Disk Drive/Solid State Drive
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Multi-in-1 Card Reader

The card reader allows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the Card Reader driver
(see“ Card Reader” on page4 - 8).

+ MMC (MultiMedia Card) / RSMMC

» SD (Secure Digital) / Mini SD / SDHC/ SDXC

*Note: Some of these cards require PC adapters that are usually supplied with the cards.

2NZ
2L &

Inserting Cards into the Card Reader

Note that the cards should be inserted with the readable side of the card facing up-
wards.

Multi-in-1 Card Reader 2 - 3

4

Push-Push Card
Reader

The card reader fea-
tures a push-in/push-out
card insertion and ejec-
tion mechanism. Simply
push the card to insert
and eject it, however

some cards require an
adapter.

Card Reader Cover

Make sure you keep the
rubber cover provided in
the card reader when
not in use. This will help
prevent foreign objects
and/or dust getting in to
the card reader.

Figure2-1
Right Views

1. Card Reader
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4

Volume Adjustment

The sound volume level
can be clicking using the
volume control icon

in the notification area
of the taskbar.

Figure2-2
Realtek Audio
Manager

Audio Features

Y ou can configure the audio options on your computer from the Sound control
pane! in Windows, or from the Realtek HD Audio Manager g icon in the notifi-
cation area/control pane! (right-click the notification areaicon gj to bring up an au-
dio menu and select Sound M anager). The volume may also be adjusted by means
of the Fn + F5/F6 key combination (see Table 1 - 2, on page 1 - 9).

>

Right-click the icon gjj to ac-
cess the menu above, and then
select Sound Manager.

See “HDMI Audio Configuration” on page C - 7 for a description of the audio configuration
when connecting an HDMI supported display device.

See “Sound Blaster Audio & HDMI/Display Port” on page 6 - 36 for more information on the
Sound Blaster Audio setup.

2 - 4 Audio Features



Setup for 5.1Surround Sound

To setup your system for 5.1 surround sound you will need to connect the audio ca-

Storage Devices, Mouse, & Audio

bles to the Headphone-Out, Microphone-In jack and S/PDIF-Out jacks.

1.

2.

. |
Audio Features 2 - 5

Click Start, and click Control Panel (or point to Settings and click Control Panel)

and make sure you are in Classic View.

Click Realtek HD Audio Manager (or right-click the notification area icon gl and

select Sound Manager).

Click Speakers (tab) and click Speaker Configuration (tab).
Select 5.1 Speaker from the Speaker Configuration pull-down menu.

Connector Settings

4

Auto Popup Dialog

You should enable the
auto popup dialog to au-
tomatically detect when a
device has been
plugged-in. If disabled,
double-click connector
settings and click the
box to enable the auto
popup  detection  of
plugged-n devices.

4

Volume Adjustment

The sound volume level
is set using the volume
control within Windows
(and the volume func-
tion keys on the comput-
er). Click the volume
icon in the notification
area to check the set-
ting.
Headphone
Configuration

It is recommended that
you set the Speaker
Configuration to Ste-
reo (not to 5.1 Speaker)
when listening through
headphones in order to
maximize audio quality.

Figure2-3
Realtek Audio
Manager - Speakers
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5. Plug in the speaker cables (you may require an adapter to connect each cable to
2 the appropriate jack e.g a stereo mini to dual RCA adapter) from your speakers
into the jacks as follows:

Headphone-Out Jack = Side Speaker Out

Microphone-In Jack = Center/Subwoofer Speaker Out
S/PDIF-Out Jack = Front Speaker Out

As you plug in each cable a dialog box will pop u.

7. Click to put a check in the appropriate box according to the speaker plugged-in
(e.g. Rear Speaker Out), and then click OK to save the setting.

8. Click OK to exit Realtek HD Audio Manager.

o

2 - 6 Audio Features
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Setup for Audio Recording
To record audio sources on your computer at optimum quality follow the instruc-

tions below:

1. Click Control Panel and make sure you are in Classic View.

2. Click Realtek HD Audio Manager (or right-click the notification area icon ﬂ and
select Sound Manager).

3. Click Microphone Effects (tab) in Microphone (tab), and then click to select
Noise Suppression (button), or adjust the Recording Volume level to around 60,
to obtain the optimum recording quality.

4. Click OK to close the control panel and save the settings.

Figure2-4
Realtek Audio
Manager -
Recording Setup

Audio Features 2 - 7
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Touchpad and Buttons/Mouse

The Touchpad is an alternative to the mouse; however, you can also add a mouse to

_ your computer through one of the USB ports. The Touchpad buttons function in
In order to improve pad hth two-butt Mak haveinstalled the Touch
S AT (L5 mucht esame\‘/‘vay asa wcﬂ- utton mouse. esureyou havein e Touch-
sary to keep the surface pad driver (see “ Touchpad” on page 4 - 8).

clean and free of finger- e .
prints and marks etc. Touchpad Sensitivity

Use a soft dry cleaning The mouse button zones at the bottom of the pad are defined by the line at the bot-
cloth to keep the pad tom of the pad, and the left and right buttonsare divided roughly down the middle.
surface clean. Press the | eft button zone for aleft click, and right button zone for aright click ac-
tion.

2N
/Q\

Touchpad Cleaning

Disabling the Pad

Use the Fn + F1 or Con-
trol Center button to dis-
able the Touchpad.

4

Mouse Driver

If you are using an external
mouse your operating system

may be able to auto-configure
your mouse during its installa-
tion or only enable its basic
functions. Be sure to check
the device’s user documenta-
tion for details.

2 - 8 Touchpad and Buttons/Mouse
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Mouse Properties Control Panel e
. . . . 7/ \Y
Y ou can configure the functions from the M ouse control panel in Windows as fol- , ,
lows Disabling the
' Touchpad
1. Right-click the Start Menu g icon.
2. Select Control Panel. If you need to disable
3. Click Mouse (Hardware and Sound > Devices and Printers). the Touchpad for any
4. Click the menu headings tabs to adjust your mouse preferences. reason (e.g. you may

find that when using
the computer’s internal
keyboard you acciden-
tally trigger the Touch-
pad when resting your
wrists or palms on it)
you can do so by using
Fn + F1 key combina-
tion.

Figure2-5
Mouse Properties
Control Panel -
Buttons

.|
Mouse Properties Control Panel 2 - 9
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Figure2-6
Mouse Properties
Control Panels

.|
2 - 10 Mouse Properties Control Panel
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Mouse & Touchpad Devices

Y ou can also configure the functions from the M ouse & touchpad control panel in
Devicesin the Settings control panel as follows.

1. Click the Settings item in the Start Menu (this is also as an App or All Settings in
the Action Center).

2. Click Devices.

3. Click Mouse & touchpad.

Figure2-7
Settings > Mouse &
touchpad

Mouse & Touchpad Devices 2 - 11
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Touchpad Settings
Y ou can disable the Touchpad by clicking the Touchpad button to turn it off.

Y ou can set the system to automatically disable the internal Touchpad when an ex-
ternal USB point device (e.g aUSB mouse) is attached. Click “L eave touchpad on
when amouse is connected” to off.

Figure2-8
Mouse & Touchpad
(Touchpad turned off

when mouse
connected) / \

2 - 12 Mouse & Touchpad Devices
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Touchapd Taps
Make sure “ Allow taps on the touchpad” ison if you want to use the tap feature.

The Delay feature hel ps prevent recognizing taps on the pad by accident, by recog-
nizing when your palm isresting on it or brushing its surface while you are typing.

Use the drop-down menu to either turn of any delay, or to adjust the delay to your

preference.
< k Figure2-9
Mouse & Touchpad
Adjust Delay

Mouse & Touchpad Devices 2 - 13
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You to use a specific gesture or taps on the surface of the pad to perform specific
actions to manipulate documents, objects and applications, and these may be en-
abled or disabled by clicking on the appropriate button.

Figure2-10
Mouse & Touchpad
Taps and Gestures

2 - 14 Mouse & Touchpad Devices
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The two-finger tap acts as a right-click mouse action and can bring up context
menus etc.

Thetwo-finger scrolling feature worksin most scrollable windows and allows you
to scroll horizontally and vertically. Place two fingers, slightly separated, on the
Touchpad surface and slide both fingersin the direction required (in a straight con-
tinuous motion).

Figure2-11

Scrolling Gesture

The two-finger pinch to zoom gesture can be used to perform the same function as
a scroll wheel in Windows applications that support CTRL + scroll wheel zoom
functionality. Placetwo fingers on the pad (for best results use thetips of the fingers)
and slide them apart to zoom in, or closer together to zoom out.

Figure2-12

Zooming Gesture

Mouse & Touchpad Devices 2 - 15
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Thethreeand four-finger taps may be configured may be used to trigger Cortana
Sear ch or the Action Center.

Figure2- 13
Mouse & Touchpad
Select Actions

Thethreefinger-drags & slides gesture may be used to enhance navigation with a
variety of applications such as browsing the Internet or scrolling through a photo
viewer.

Figure2- 14
Slide Gesture

2 - 16 Mouse & Touchpad Devices
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Thefollowing isan overview of the main gestures you can use with your Touchpad.

Figure2- 15
Touchpad
Gestures

Mouse & Touchpad Devices 2 - 17
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Chapter 3. Power Management >
Overview OS Note 3
Power management .

To conserve power, especially when using the battery, your computer power man- functions will vary slight-
agement conserves power by controlling individual components of the computer | |y gepending on your
(the monitor and hard disk drive) or the whole system. This chapter covers: operating system. For
more information it is
best to refer to the user’s
manual of your operat-
ing system.

» The Power Sources

* Turning On the Computer

» Power Plans

» Power-Saving States

» Configuring the Power Buttons
» Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OSto set devicesinto low-power states based on user set-
tings and information from applications.

. |
Overview 3 - 1
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4

Forced Off

If the system “hangs”,
and the Ctrl + Alt + Del
key combination doesn’t
work, press the power
button for 4 seconds, or
longer, to force the sys-
tem to turn itself off.

The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter

Useonly the AC/DC adapter that comeswith your computer. Thewrong type of AC/
DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack at the rear of the computer.

2. Plug the AC power cord into an outlet, and connect the AC power cord to the AC/
DC adapter (make sure you use the adapter when first setting up the
computer, as to safeguard the computer during shipping, the battery will be locked
to not power the system until first connected to the AC/DC adapter).

3. Raise the lid/LCD to a comfortable viewing angle.

4. Press the power button to turn “On”.

Battery

The battery allows you to use your computer while you are on the road or when an
electrical outlet isunavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely beforerecharging (see “ Battery FAQ” on page 3 - 21).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “ Battery Information” on page 3 - 17.

3 - 2 The Power Sources
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Turning On the Computer

Now you are ready to begin using your computer. To turnit on simply pressthe pow-

er button on the front panel.
When the computer is on, you can use the power button as a Stand by/Hibernate/
Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and
holding the power button for longer than this will shut the computer down). Use

Power Options (Hardware and Sound) in the Windows control panel to configure
this feature.

4

Power Button as Stand by or Hibernate Button

You can use the OS's “Power Options” control panel to set the power button to send the
system into Stand by or Hibernate mode (see your OS’s documentation, or “Configuring
the Power Buttons” on page 3 - 9 for details).

Turning On the Computer 3 - 3
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Shutting the Computer Down

Note that you should always shut your computer down by choosing the Shut down
command asthiswill help prevent hard disk or system problems. Use the Power
item in the Start M enu and select Shut down.

Y ou can also use the context menu (right-click the Start Menu gg icon or pressthe
Windows logo gg@ + X key combination) to Sign out, Sleep, Hibernate, Shut
down, and Restart.

If you want to add Hibernate/Sleep to the Power Menu see “ Adding Hibernate/
Sleep to the Power Menu” on page 3 - 10.

Figure3-1
Shut Down/Restart

3 - 4 Shutting the Computer Down
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Power Plans

The computer can be configured to conserve power by means of power plans (Con- Z _
trol Panel > Power Options). You can use (or modify) an existing power plan, or Resuming
create anew one. Operation

See Table3 - 1, on

The settings may be adjusted to set the display to turn off after a specified time, and S - 1 Gar s

to send the computer into Sleep after a period of inactivity. tion on how to resume
from a power-saving

Click Change plan settings and then click Change advanced power settingsto ac- || state.

cess further configuration optionsin Advanced Settings.
Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure3-2

Power Plan
P— - Advanced Settings
N ——

Power Plans 3 - 5
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Figure3-3

Power Plans

Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. Thisisworth bearing in mind if you are experiencing
any reduced performance (especialy under DC/battery power).

Choose High perfor mance (you may need to click Show additional plansto view
the High performance plan) for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered.

Click to Show/Hide
additional
power plans
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Y ou can use power-saving states to stop the computer’ s operation and restart where
you left off. Windows 10 uses the Sleep, Hiber nate and Shut Down power-saving
states.

Sleep

In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power.

The PC wakes from Sleep within seconds and will return you to where you last | eft
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save all the
information to the hard disk and shut the computer down before the battery becomes
depleted.

To add Sleep to the Power Menu see “Adding Hibernate/Sleep to the Power
Menu” on page 3 - 10.

.|
Power-Saving States 3 - 7
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Wake On LAN
Support

Wake-On-LAN is only
supported from Sleep or
Hibernate states in
Windows.

If you require your com-
puter to wake up from
network activity in Win-
dows then make sure
that the computer is ei-
ther in Sleep or Hiber-
nate.

Wake-On-LAN is not
supported from Shut-
down states in Win-
dows.
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Figure3-4
Power Button &
Start Menu Power

Hibernate

Hiber nate uses the least amount of power of al the power-saving states and saves
al of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last |eft off within seconds. Y ou should
put your mobile PC into Hiber nate if you will not use the computer for a period of
time, and will not have the chance to charge the battery. To add Hiber nate to the
Power Menu see “ Adding Hibernate/Sleep to the Power Menu” on page 3 - 10.

Shut down

Y ou should Shut down the computer if you plan to install new hardware, plan to be
away from the computer for several days, or you do not need it to wake up and run
ascheduled task. Returning to full operation from Shut down takeslonger than from
Sleep or Hibernate.

.|
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Configuring the Power Buttons

The power/sleep button (Fn + F12 key combo) and closed lid may be set to send the Z
computer in to a power-saving state. Click Choose what the power buttons do on Password
the left menu in Power Options to bring up the menu. Protection

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure3-5
Power Options
Define Power
Buttons

.|
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Adding Hibernate/Sleep to the Power Menu
Add Hibernate/Slegp to the Power Menu as follows.

Go to the Power Options (Hardware and Sound) control panel (see page 1 - 32).
Click “Change settings that are currently unavailable” @ change settings that are currently unavailzble .
Click Choose what the power buttons do.

Click to put a check in the Hibernate/Sleep box under Shutdown settings.

Click Save Changes and close the control panel.

aorwNPE

Figure3-6
Power Options
Define Power
Buttons - Shutdown
Settings

3 - 10 Configuring the Power Buttons
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Resuming Operation
Y ou can resume operation from power-saving states by pressing the power button,
or in some cases pressing the sleep button (Fn + F12 key combo).

Power Status Icon Color To Resume

Table3-1

Power Off Off Press the Power Button Resuming

Press the Power Button Operation
Sleep Blinking Green Press the Sleep Button (Fn + F12 Key
Combo)
Off (battery)
Hibernate Press the Power Button
Orange (AC/DC adapter)
Display Turned Off Green Press a Key or Move the Mouse/Touchpad

4

Closing the Lid

Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down
hot key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down).

If you have chosen to
send the computer to
Sleep when the lid is
closed, raising the lid
will wake the system up.

Configuring the Power Buttons 3 - 11
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Power Conservation Modes

is system supports Power Saving power management featuresthat place comput-
4 Thi Power Savi f hat pl
3 Power Conservation ers (CPU, hard drive, etc.) into alow-power sleep modes after a designated period
Modes of inactivity. Adjust Power Conservation Modes from the Control Center:

The Power Saving set-
ting will result in maxi-
mum power saving, but
with the possible loss of
some performance.

1. Pressthe Fn + Esc key combination to toggle the Control Center on/off.
2. Click either the Performance, Balanced or Power Saving button.

Setting the mode to Bal-
ance will give power
saving matched with
performance.

Performance will give
optimum computer per-
formance but with less
power conservation.

Note that the Energy
Star setting will put the
display into sleep after
no more than 15 min-
utes of user inactivity.

Figure3-7
Control Center

.|
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Ctrl + Alt + Delete Key Combination

YoucanusetheCTRL + ALT + DEL key combination from almost any of the Win-

dows 10 interfaces/Apps to bring up a full-screen displaying L ock, Switch User,

Sign out, Change a password and Task Manager options. If you click the Power
icon in the lower right corner of the screen a power management option menu ap-

pearsto display Sleep, Shut down, and Restart.

Figure3-8
Ctrl + Alt + Delete
Menu

To fully control al the power options (including Hibernate mode) go to the Power
Options control panel and configure the power button, sleep button and lid to per-
form the function selected.

.|
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Settings Menu Power Controls

The Settingsiteminthe Start M enu (and also asan App) givesyou accessto anum-

ber of power settings control panels which enable you to quickly adjust power op-
tions. Click System to access the menu including the power option settings.

O

Figure3-9
Settings

3 - 14 Settings Menu Power Controls
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Battery Saver

Battery Saver will display the battery level, and by clicking Battery Use you can see

the current state of battery usage by application etc. Click Battery saver settingsto

adjust the battery saver level.

Figure3- 10
Settings > Battery
Saver

Settings Menu Power Controls 3 - 15
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Power & Sleep
Power & sleep gives you quick access to Screen and Sleep settings. Click Addi-

tional power settingsto go to the main power options control panel.
Figure3- 11
Settings > Power &
Sleep
Ll D
e
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Battery Information e
Low Battery
Battery Power Warning
Y our computer’s battery power is dependent upon many factors, including the pro-
grams you are running, and peripheral devices attached. Y ou can set actions to be
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from FEeiEes N ble
power plan Change plan settings > Change advanced power settings (see Figure R elEEC ARG lIE:

3-3o0npage3-6) or save your work, oth-
) erwise, the unsaved

Click the battery icon in the notification areato seethe current battery level and  FCEERIRENEE S
charge status (you can also click Power & sleep settings to access the Settings § s NERERERIECLE
menu to quickly adjust power settings).

Follow these simple guidelines to get the best use out of your battery.

When the battery is criti-
cally low, immediately

Figure3- 12
Battery Icon
(Notification Area) &
Battery Advanced
Settings

Battery Information 3 - 17
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Conserving Battery Power

Z » Useapower plan that conserves power (e.g Power saver), however note that
Windows Mobility this may have an affect on computer performance.
Center « Lower the brightness level of the LCD display. The system will decrease LCD
The Windows Mobility brightness slightly to save power when it is not powered by the AC/DC adapter.

gf)r\],tigés Z%merglsy ppa:)r;ﬁ: * Reduce the amount of time before the display is turned off.

of access forinformation | « Close wireless, Bluetooth, modem or communication applications when they are

on battery status, power not being used.

plans used and wireless ] _ )

device status etc. » Disconnect/remove any unnecessary external devices e.g. USB devices,
ExpressCards etc.

Figure3- 13
Windows Mobility
Center
(Control Panel)

.|
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Battery life may be shortened through improper maintenance. To optimize the life
and improveits performance, fully discharge and recharge the battery at least
once every 30 days. We recommend that you do not remove the battery yourself.

New Battery

Always completely discharge, then fully charge, a new battery (see “ Battery FAQ”
on page 3 - 21 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter

The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hoursto fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery chargetimeisless. Refer to “ LED Indica-
tors’ on page 1l - 7 for information on the battery charge status, and to “ Battery
FAQ” on page 3 - 21 for more information on how to maintain and properly re-
charge the battery pack.

.|
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Proper handling of the Battery Pack

ﬂ‘ * DO NOT disassemble the battery pack under any circumstances
Caution * DO NOT expose the battery to fire or high temperatures, it may explode

5 o * DO NOT connect the metal terminals (+, -) to each other
anger of explosion if

battery is incorrectly re-
placed.

2AN\Z
I

Damaged Battery Warning

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.

Should you notice any physical defects (e.g. the battery is bent out of shape after being

dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your distributor/supplier. If the battery has been dropped we
do not recommend using it any further, as even if the computer continues to work with a
damaged battery in place, it may cause circuit damage, which may possibly result in fire. It
is recommended that you replace your computer battery every two years.

.|
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Battery FAQ

How do | completely discharge the battery?

Use the computer with battery power until it shuts down due to alow battery. Don't

turn off the computer even if amessage indicates the battery iscritically low, just let
the computer use up al of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.

Figure3- 14
Power Plan Create

.|
Battery Information 3 - 21



Power Management

3. Click Change plan settings (after creating it) and click Change plan settings >
Change advanced power settings.

Figure3- 15
Change Plan
Settings / Change
Advanced Power
Settings
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

Figure3- 16
Power Options
Advanced Settings -
Battery

* Low battery levels= 0%

» Critical battery Levels=1%

» Low battery action = Do Nothing

» Critical battery action (On battery) = Shut Down
 Critical battery action (Plugged in) = Do Nothing

.|
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How do | fully chargethe battery?
When charging the battery, don’t stop until the LED charging indicator light changes

from orange to green.
How do | maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.

.|
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Chapter 4: Drivers & Utilities

This chapter dealswith installing the drivers and utilities essential to the operation or
improvement of some of the computer’s subsystems. The system takes advantage of
some newer hardware components for which the latest versions of most available op-
erating systems haven’t built in drivers and utilities. Thus, some of the system com-
ponents won't be auto-configured with an appropriate driver or utility during
operating system installation. Instead, you need to manually install some system-re-
quired drivers and utilities.

What to Install

You will need to attach an external optical CD/DVD devicedriveto install the
driversfrom the Device Drivers & Utilities + User’s Manual disc. The disc con-
tains the drivers and utilities necessary for the proper operation of the computer. Ta-
ble4 - 1, on page 4 - 4 lists what you need to install and it is very important that
thedriversareinstalled by the method outlined in thischapter, and in the or der
indicated. Note that the information on the following pagesis for Windows 10 (64-
bit only).

Module Driver Installation

The procedures for installing drivers for the Wireless LAN, Bluetooth & WLAN
Combo, Intel Technology, Sound Blaster Cinemaand 3G/4G modules are provid-
edin“Modules’ on page6 - 1.

. |
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Drivers & Utilities

\ 7/
L&
Driver Installation &
Power

When installing driv-
ers make sure your
computer is powered
by the AC/DC adapter
connected to a work-
ing power source.
Some drivers draw a
significant amount of
power during the instal-
lation procedure, and if
the remaining battery
capacity is not adequate
this may cause the sys-
tem to shut down and
cause system problems
(note that there is no
safety issue involved
here, and the battery will
be rechargeable within 1
minute).
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Driver Installation

Insert the Device Drivers & Utilities + User’s Manual disc into an attached DVD drive.
Click the message “Tap to choose what happens with this disc.”

Click Run autorun.exe.
Click Install Drivers (button), or Option Drivers (button) to access the Optional driver menu.

PN

Figure4 - 1- Drivers Installer Screen 1

. |
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5. Check the driver installation order from Table 4 - 1, on page 4 - 4 (the drivers must be installed in this order)
which is the same as that listed in the Drivers Installer menu below.

Click to select the driver you wish to install, (you should note down the drivers as you install them).

7. Follow the instructions for each individual driver installation procedure as listed on the following pages.

o

Figure4 - 2 - Install Drivers
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Win 10 (64-bit) Driver Page # Win 10 (64-bit) - Optional Items Page #
Chipset Page 4-7 Wireless LAN Module Page 6 - 10
Video (VGA) Page 4 -7 Bluetooth & WLAN Combo Module Page 6 - 15
NVIDIA Video (VGA) Page 4 -7 Intel® Software Guard Extensions Driver Page 6 - 20

Intel® Rapid Storage Technology

LAN Page4-8 (required for hard disks in AHCI or Optane mode) Page 6-21
Card Reader Page 4 -8 | Sound Blaster Audio Page 6 - 28
Touchpad Page 4 -8 PC Camera (no driver installation required) Page 6 - 38
Airplane Page 4 -8 | Trusted Platform Module (no driver installation required) Page 6 - 43
Control Center Page 4 -8 3G/4G Module (no driver installation required) Page 6 - 49
MEI Driver Page 4-9

Audio Page 4-9

All drivers provided are for the Windows 10 (64-hit) operating system.

Table 4 - 1 - Driver Installation
Notethat you need toinstall both the WLAN & Bluetooth driversfor the WLAN & Bluetooth Combo modules.

. |
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Manual Driver Installation

Click Browse CD/DVD (button) inthe Driversinstall-
er application and browse to the executable file in the
appropriate driver folder.

Windows Update

After installing all the drivers make sure you enable
Check for updates (Settings > Update & security >
Check for updates) in order to get al the latest secu-
rity updatesetc. (all updateswill includethe latest hot-
fixes from Microsoft). See “Windows Update” on
page 4 - 9 for instructions.

Drivers & Utilities

Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs icon (Programs > Unin-
stall a program). Click to select the driver (if it is not
listed see below) and click Uninstall, and then follow
the on screen prompts (it may be necessary to restart
the computer). Reinstall the driver as outlined in this
chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Go tothe Control Panel).

2. Double-click Device Manager (Hardware and
Sound > Devices and Printers > Device
Manager).

3. Double-click the device you wish to update/reinstall
the driver for (you may need to click “+” to expand
the selection).

4. Click Driver (tab) and click the Update Driver or
Uninstall button and follow the on screen prompts.

Driver Installation 4 - 5
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User Account Control

If aUser Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow theinstallation procedure as direct-
ed.

Windows Security Message

If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or “Install” to continue the
installation procedure.

Y ou will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
aready received certification for Windows.

New Hardware Found

If you see the message “New Hardware Found” dur-
ing the installation procedure (other than when out-
lined in the driver install procedure), click Cancel
to close the window, and follow the install ation proce-
dure.

4 - 6 Driver Installation

4

Driver Installation General Guidelines

The driver installation procedure outlined in this Chapter
(and in Chapter 7 Options & Modules), are accurate at
the time of going to press.

Drivers are always subject to upgrade and revision so
the exact procedure for certain drivers may differ slight-
ly. As a general guide follow the default on screen in-
structions for each driver (e.g. Next > Next > Finish)
unless you are an advanced user. In many cases a re-
start is required to install the driver.

Make sure any modules (e.g. WLAN or Bluetooth) are
ON (i.e. the system is not in Airplane Mode) before
installing the appropriate driver.



Driver Installation Procedure

Insert the Device Drivers & Utilities+ User’s Manual
discinto an attached DVD driveand click I nstall Driv-
ers (button).

Chipset

Note: During thedriver installation processthe screen
resolution may change. Make sureyou restart after the
driver installation process, as instructed, in order to
restore the original resolution.

1. Click 1LiInstall Chipset Driver > Yes.
2. Click Next > Accept > Install.
3. Click Restart Now to restart the compulter.

Video (VGA)

1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes> Next > Next.

3. Click Finish to restart the computer.

Drivers & Utilities

NVIDIA Video (VGA)

1.
2.

3.

Click 3.Install NVIDIA VGA Driver > Yes.
Click AGREE AND CONTINUE (button) to
accept the terms of the license agreement.
Click Next.

Click the Close button to complete the installa
tion.

After all the drivers have been installed (an
internet connection is required) run the
NVIDIA GeForce Experience by clicking the
desktopicon  (or App).

Note: After installing the video driver go to the Dis-
play control panel to adjust the video settings to the
highest resolution.

Driver Installation 4 - 7




Drivers & Utilities

LAN

Note: If the computer enters a deep sleep mode during
installation, you will be prompted to plug in a network
cable, and click OK, to continue installation. If a net-
work cable is not available, restart the systemand re-
install the LAN driver.

1. Click4.Install LAN Driver > Yes.

2. Click Next > Install.

3. Click Finish.

Card Reader

1. Click 5.Install Cardreader Driver > Yes.
2. Click Finish.

Touchpad

1. Click 6.Install Touchpad Driver > Yes.

2. Click Next.

3. Click the button to accept the license agreement
and click Next.

4. Click Finish > Restart Now to restart the com-
puter.

Airplane
Note: Do not use Update Driver in Device Manager to
install the Airplane mode driver.

1. Click 7.Install Airplane Driver > Yes.
2. Click Next > Install.
3. Click Finish to restart the computer.

Control Center

Click 8.Install Control Center AP > Yes.
Click Next > Install.

Click Finish to restart your computer.

After restart a control panel will pop-up to alow
you to select the type of keyboard for your system
(see” Flexikey® Application” on page1- 11
and Appendix B).

~pwbdE

4 - 8 Driver Installation



Drivers & Utilities

MEI Driver It is recommended that you install the Sound Blaster
1. Click 9.Install MEI Driver > Yes. Audio application (see “Sound Blaster Audio” on
2 Click Next. page 6 - 28) and Intel Rapid Storage Technology

driver (see “Intel® Rapid Storage Technology” on

3. Click the check box to accept the license and nage 6 - 21 - required for HDDsin AHCI mode).

then click Next.
4. Click Next. »
5. Click Finish.

Windows Update

Audio After installing all the drivers make sure you enable Win-

. . . dows Update in order to get all the latest security up-
1. Click 10. Install Audio Driver > Yes. dates etc. (all updates will include the latest hotfixes

2. Click Next > Next. from Microsoft).

3. Click Finish to restart the computer. To enable Windows Update make sure you are con-
nected to the internet:

After installing the audio driver the system will not re- 1. Go to the Control Panel.

turn to the Drivers I nstaller screen. To install any of 2. Click Windows Update (System and Security/

the optional drivers, gject the Device Drivers & Utili- STE1)

3. Click Check for updates (button).

ties +_User S Manu_al d'$ and then reinsert it (or dC_’U' 4. The computer will now check for updates (you
ble-click the disc icon in My Computer), and click need to be connected to the internet).
Option Drivers (button) to access the optional driver 5. Click Install now (button) to begin checking for the
menu. updates.

6. Click Install updates (button) to install the

updates.
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Optional Drivers

See the pages indicated in Table 4 - 1, on page 4 - 4 for the driver installation procedures for any modules in-
cluded in your purchase option.

Figure 4 - 3 - Optional Drivers Installer Screen
Notethat you need toinstall both the WLAN & Bluetooth driversfor the WLAN & Bluetooth Combo modules.

. |
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BIOS Utilities

Chapter 5: BIOS Utilities -

/ \Y

BIOS Screens

Overview
. . L : . Note that the BIOS
This chapter gives abrief introduction to the computer’s built-in software: sfreeens . pictu?ed on
these pages are intend-
Diagnostics: The POST (Power-On Self Test) ed for guidance in set-

ting up your system'’s
BIOS.

Configuration: The Setup utility
If your computer has never been set up, or you are making important changestothe B =ee e e o
system (e.g. hard disk setup), then you should review this chapter first and note the BT ERE S ERRETRE
original settings found in Setup. Even if you are abeginner, keep arecord of the set-  JFEUCREUEICIEGEEE
tings you find and any changes you make. This information could be useful if your AU EaSE e
- screens may appear
System ever needs servicing. slightly different from
those pictured on these

There is one general rule: Don’t make any changes unless you are sure of what you  JElkEs
aredoing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service

representative.

. |
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The Power-On Self Test (POST)

If you enable the Boot-time Diagnostic Screen in the Setup Utility, each time you
turn on the computer the system takes afew seconds to conduct a POST, including
aquick test of the on-board RAM (memory).

BIOS Settings
Warning

Incorrect settings can ) ) ) )
U s e ool Asthe POST proceeds, the computer will tell you if thereis anything wrong. If there

malfunction. To correct isaproblem that prevents the system from booting, it will display a system summary

mistakes, return to Set' and promp‘t you to run %tup'
up and restore the Opti-

WIEECERPEERLERIIGUEE | f there are no problems, the Setup prompt will disappear and the system will load
SES= the operating system. Once that starts, you can't get into Setup without rebooting.
UEFI Boot & POST

When UEFI Boot is en-
abled, then the prompts
to press F2 or F7 will
not appear. However
you can still press F2 to
enter the setup, or F7 to
choose the preferred
boot device, if you press
the key immediately the
system boots up.

5 - 2 The Power-On Self Test (POST)
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Failing the POST
Errors can be detected during the POST . There are two categories, “fatal” and “non-
fatal”.

Fatal Errors

These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
distributor/supplier as soon as possible.

Non-Fatal Errors

This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) and you can then press F7 (the F7 on screen
will be highlighted to illustrate that the system is processing the request) for boot op-
tions.

Press F2 (give the system a few seconds to enter Setup; the F2 on screen will be
highlighted to illustrate that the system is processing the request) to run the Setup
program and try to correct the problem. If you still get an error message after you
change the setting, or if the “cure” seems even worse, call for help.

The Power-On Self Test (POST) 5 - 3
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BIOS Settings
Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Opti-
mized Defaults with
<F3>.

The Setup Utility

The Aptio Setup Utility tells the system how to configure itself and manage basic
features and subsystems (e.g. port configuration).

Entering Setup

To enter Setup, turn on the computer and press F2 (give the system a few seconds
to enter Setup; the F2 on screen will be highlighted to illustrate that the system is
processing the request) during the POST (or press F7 for boot options). If you get a
“Keyboard Error”, (usually because you pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.

To see the boot options press F7.

5 - 4 The Setup Utility
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Setup Screens
The following pages contain additional advice on portions of the Setup. Along the Z

top of the screen is a menu bar with menu headings. When you select a heading, a Setup Menus
new screen appears. Scroll through the features listed on each screen to make chang-
esto Setup.

The Setup menus
shown in this section are

for reference only. Your
computer's menus will
indicate the configura-
tion appropriate for your
model and options.

Instructions on how to navigate each screen are in the box at the bottom right side of
the screen.

Figure5-1
Navigation Menu

If these tools are confusing, press F1 to call up a General Help screen, and then use
the arrow keys to scroll up or down the page.

Theltem Specific Help on the upper right side of each screen explainsthe highlight-
ed item and has useful messages about its options.

If you see an arrow - next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.
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Main Menu

Aptio Setup Utility — Copyright (C) 2016 American Megatrends Inc.

Figure5-2
Main Menu

System Date:

SATA Port # (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of a optical Device/
HDD on the computer’s SATA Ports.

5 - 6 Main Menu
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OffBoard SATA/NVme Controller Configuration (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of any devices on the
off board SATA/NVme Controller if applicable.

System Time & Date (Main Menu)

The hour setting uses the 24-hour system (i.e., @@ = midnight; 13 = 1 pm). If you
can change the date and time settingsin your operating system, you will also change
these settings. Some applications may also alter datafiles to reflect these changes.

SystenVExtended Memory (Main Menu)
Thisitem containsinformation on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

MB Series / BIOS Revision / KBC/EC firmware Revison/Mac Address (Main
Menu)

This item contains information on the BIOS version, and the identifier address for
the device on anetwork, and is not user configurable.

. |
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Figure5- 3
Advanced Menu

Advanced Menu

Aptio Setup Utility — Copyright (C) 2016 American Megatrends Inc.

P Advanced Chipset Control

Advanced Chipset Control (Advanced Menu)
The sub-menu here allows you to change the settings for the GPU Perfor mance
Scaling, FlexiCharger, SW Guard Extensionsand VT-d.

GPU Performance Scaling (Advanced Menu > Advanced Chipset Control)

You can enable/disable NVIDIA GPU Performance scaling from this menu. The
NVIDIA Card doesthe scaling if thisoption ison, and has less |atency than the I ntel
GPU. This can be useful if you play games etc.

5 - 8 Advanced Menu



FlexiCharger (Advanced Menu > Advanced Chipset Control)

The sub-menu here allows you to enabl e/disable the FlexiChar ger . The FlexiCharg-
er may be set to automatically start charging your battery when the battery reaches
acertain capacity level (e.g. you could start the battery charge level at 40%).

Seethesidebar warningfor information on runningthe FlexiChar ger for an ex-
tended period asthisis not recommended.

Aptio Setup Utility — Copyright (C) 2016 American Megatrends Inc.

FlexiCharger [Enabled]

Software Guard Extensions (Advanced Menu > Advanced Chipset Control)
Intel provides SGX, which isaset of instructions allowing user-level code a degree
of security, and privacy, from the operating system. This s disabled by default and
should be enabled before installing the driver (see page 6 - 20).

VT-d (Advanced Menu > Advanced Chipset Control)

Enable/disable Intel® Virtualization Technology for Directed 1/0 (VT-d) from
this menu. This extends Intel's Virtualization Technology (VT) by providing hard-
ware assists for a virtualization solution.

BIOS Utilities

FlexiCharger
Warning

If you leave the FlexiCh-
arger continuously "En-
abled” for a period of
three months or more,
the battery meter's read-
ing accuracy will deteri-
orate.

To reset this, set the
FlexiCharger to "Dis-
abled", and then allow
the battery to completely
discharge (see

before enabling the
function again.

Figure5-4
Advanced Chipset
Control >
FlexiCharger
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Intel® Optane™

Intel® Optane™ is a combi-
nation of a compatible
memory device and Intel
Rapid Technology soft-
ware. This combination is
designed to speed up your
system performance.

Contact your distributor or
supplier to see if your sys-
tem supports this technolo-
ay.
SATA Mode
Selection

If you have installed the
Windows OS with either
AHCI or Intel RST (Op-
tane) mode enabled, DO
NOT disable the set mode
(if you wish to disable the
set mode you will need to
reinstall the Windows OS).

SATA Mode (Advanced Menu)
The SATA (Serial ATA) control is configured to operatein AHCI (Advanced Host
Controller Interface) mode or in Intel RST Premium (for I ntel® Optane™) mode.

The SATA M odeshould be set BEFORE installing an oper ating system, and after
you have backed up all necessary filesand data (see sidebar). See“ Setting Up SATA
Mode (Optane™ or AHCI)” on page 6 - 2 for details. Make sure you install the I n-
tel Rapid Storage Technology application if you have set the SATA Modeto I ntel
RST Premium, or to AHCI (see*“Intel® Rapid Storage Technology” on page 6 -
21).

If you wish to change your SATA mode to/from AHCI/Intel RST (Optane) mode
note that doing so may prevent your operating system from booting, and may require
areinstall of the OS. If you do wish to change the SATA mode then backup any nec-
essary dataon your hard disk(s) asyou will need wipethe disks clean in order to pre-
vent system problems.

Power On Boot Beep (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.

5 - 10 Advanced Menu
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Security Menu

Aptio Setup Utility — Copyright (C) 2016 American Megatrends Inc.

4

Security Menu

The changes you make
here affect the access
to the Setup utility itself,
and also access to your
machine as it boots up
after you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in your
software OS.

Secure Boot Mode [Standard]

Secure Boot Mode
Standard
Custom

Figure5-5
Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Aptio Setup Utility. This will not affect
access to the computer OS (only the Aptio Setup Utility).

Security Menu 5 - 11
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NG
A&

Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled”), NEVER
forget your password.

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.

5 - 12 Security Menu

Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.

Note: You can only set the user password after you have set the supervisor pass-
word.

Set User Password (Security Menu)

Y ou can set a password for user mode access to the Aptio Setup Utility. Thiswill
not affect access to the computer OS, (only the Setup utility) unless you choose to
set a Password on Boot (see below). Many menu items in the Aptio Setup Utility
cannot be modified in user mode.

Note: You can only set the user password after you have set the supervisor pass-
word.

Password on boot: (Security Menu)

Specify whether or not apassword should be entered to boot the computer (you may
only set a password on boot if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the
warning in the sidebar). The default setting is “Disabled”.
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Secure Boot Control (Security Menu)

Secure Boot Control prevents unauthorized operating systems and software from
loading during the startup process. Secur e Boot is available asamenu option if you
have enabled UEFI Boot (see” Boot Menu” on page 5 - 15). Enabling Secure Boot
will bring up the Secur e Boot M ode menu to enable you to configure Secure Boot
as Standard (with a fixed secure boot policy), or Custom (which enables you to
make changes to the Key M anagement database).

Aptio Setup Utility — Copyright (C) 2016 American Megatrends Inc.

Provision Factory Defaults [Enabled]

Figure5-6
Security -
Secure Boot
(Key Management)
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Figure5-7
Security Device
Support

TPM Configuration (Security Menu)

This sub-menu will allow you to enable/disable Trusted Platform Module (TPM)
support, and to configure the TPM State. Select TPM Configuration and press En-
ter to access the sub-menu. Press Enter to accessthe Security Device Support menu
and select Enableto support TPM. Y ou can select Pending oper ation, and then se-
lect TPM clear to clear existing TPM information in order to reset the TPM.

Aptioc Setup Utility — Copyright (C) 2016 American Megatrends Inec.

Security Device Support
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Boot Menu
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Boot .
Figure5-8
Boot Option #1 [Windows Boot Manager B()Ot hﬂer]u
(P2: WDC
WD50000LPCX~-22VHATO) ]

SN
ALK

BIOS Screens

Note that the BIOS
screens  pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.

BIOS versions are sub-
ject to constant change
and revision, therefore

S . your computer's actual
When you turn the computer on it will look for an operating system (e.g. Windows TS TR Cpeey

7) from the devices listed in this menu, and in this priority order. If it cannot find ~ EESFRRIENHAEAEE T
the operating system on that device, it will try to load it from the next device in the B GEEETREEL R NG
order specified in the Boot Option Priorities. pages.

Boot Menu 5 - 15
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" Boot Option Priorities (Boot Menu)

ﬂ: Press Enter to select the Boot Option # and use the arrow keys to select any device
UEFI Boot in order to move its boot priority up and down the list (the selected device will be
highlighted in white).

UEFI Boot is “Enabled”
;g:lty S ESU TS  UEFI Boot (Boot Menu)

Enable/disable UEFI Boot from this menu. The Unified Extensible Firmware Inter-
ISER e EEREERl  face (UEFI) specification provides a clean interface between operating systems and
VEILCERRESRNEEREEURE  platform firmware at boot time. In contrast to BIOS, UEFI defines a set of standard
SR EEER IR oot and runtime services. The Network Stack item will be enabled as an option un-

10/8.1/8 operating sys-
tems, however if you are der UEFI Boot.

running the Windows 7
OS then you should set
UEFI Boot to “Disabled”
(for other operating sys-
tems please check the
OS’s documentation).

. |
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Exit Menu

Aptio Setup Utility — Copyright (C) 2016 American Megatrends Inc.

o Figure5-9
Exit Menu

Save Changes and Reset

Click Save Changes and Reset to save al changes made. Choosing to Discard
Changes, or Exit Discarding Changes, will wipe out any changes you have made
to the Setup. Y ou can also choose to restore the original Setup defaults that will re-
turn the Setup to itsoriginal state, and erase any previous changes you have madein
aprevious session.
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Chapter 6: Modules

Overview

This chapter contains the information on the various modules (some of which are
optional) which may come with your computer, depending on the configuration
purchased. If you are unsure please contact your service representative.

The chapter includes information on the following:

» Setting Up SATA Mode (Optane™ or « Intel® Rapid Storage Technology
AHCI) » Sound Blaster Audio

* WirelessLAN Module » PC Camera

¢ Bluetooth & WLAN Combo Module Trusted Platform Module

* Inte® Software Guard Extensions 3G/4G Module
Driver

. |
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SATA Mode
Selection

The SATA mode selec-
tion should be made be-
fore installing your
operating system.

DO NOT change your
selected SATA mode
unless you intend to re-
install your operating
system. Make sure you
have backed up all your
data before doing so.

See

Setting Up SATA Mode (Optane™ or AHCI)

AHCI Mode

Advanced Host Controller Interface (AHCI) is an interface specification that allows
the storage driver to enable advanced serial ATA features such as Native Command
Queuing (for maximum hard disk efficiency and performance). Make sure you in-
stall the Intel® Rapid Storage Technology application to support your HDDg/
SSDsin AHCI mode (see “ Intel® Rapid Storage Technology” on page 6 - 21).

Intel® Optane™

Intel® Optane™ isacombination of acompatible memory device and I ntel Rapid
Technology software. This combination is designed to speed up your system per-
formance by caching boot data, executables, frequently accessed data and system
page files to an non volatile, low latency Intel® Optane™ SSD.

Contact your distributor or supplier to seeif your system supports this technology.

Intel® Rapid Storage Technology Application

Make sure you install the Intel® Rapid Storage Technology application if you
have set up your system in Intel RST Premium (for Intel® Optane™) mode (see
“Intel® Rapid Storage Technology” on page 6 - 21).

After setting the SATA modeto Intel® Optane™ and installing the I ntel® Rapid
Storage Technology application, DO NOT uninstall the Intel® Rapid Storage
Technology application.

6 - 2 Setting Up SATA Mode (Optane™ or AHCI)



Modules

Intel® Optane™ Setup Procedure

Afterinitial setup make sureyouinstall thelntel Rapid Storage Technology driver
- see“|RST Driver Installation” on page 6 - 21).

See also “ Clearing I ntel® Optane™” on page 6 - 7 (however backup up any neces-
sary filesand data befor edeleting an Optane setup, asdoing so will result intheloss
of al data on the volumes).

Y ou need to setup Intele Optane™ before installing your Windows 10 operating
system, and you will need to prepare the following in order to do so.

* The Microsoft Windows 10 OS DVD.

An attached external DVD drive.

An Intel® Optane™ SSD installed in your system.
The Device Drivers & Utilities + User’s Manual disc.

Start-up your notebook computer and press <F2> to enter the BIOS.

Go to the Boot menu, select UEFI Setting and press <Enter> (see page 5 - 15).
Set UEFI Boot to “Enabled”.

Press <Esc> to exit the menu and go to the Main menu.

Select OffBoard NVMe Controller Configuration and press enter to check that
an Intel® Optane™ SSD is present.

Press <Esc> to exit the menu and go to the Advanced menu.

aprwNE

o
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7. Select SATA Mode (see page 5 - 10), press <Enter> and select “Intel RST

Premium”.
Figure6-1
SATA Mode

SATA Mode:
AHCT Mode
Selection (BlOS) Intel RST Premium

8. Press <F4> and <Yes> to “Save Changes and Reset".

9. As the computer restarts press <F2> to enter the BIOS again.

10. Go to Intel(R) Rapid Storage Technology (Advanced menu) and press <Enter>.

11. . (Note this item only appears after you have restarted and accessed the BIOS
again after having set SATA Mode to Intel RST Premium.)

Aptio Setup Utility — Copyright (C) 2017 American Megatrends Inc.

Figure6- 2
Intel(R) Rapid
Storage Technology
(Advanced Menu)

p PCIe 1.0 INTEL MEMPEKIW016GA FUBT704300GR0O16D, 13.4GB

12. If you are reinstalling a system that has previously been setup in Intel RST
Premium mode, make sure you have cleared the Intel Optane Memory (see
“Clearing Intel® Optane™” on page 6 - 7).

6 - 4 Setting Up SATA Mode (Optane™ or AHCI)



13.

14.
15.
16.

17.
18.
19.
20.
21.
22.
23.

24,

Press <F4> and <Yes> to “Save Changes and Reset”, however ensure that the
condition in the bulleted point below is met before doing so.

Make sure the Windows 10 OS DVD isin the attached DVD drive, as the com-
puter starts up it will automatically boot from the Windows 10 OS DVD (you
will be prompted to press a key to boot from the DVD).

Press <F7> as the computer starts up to bring up the boot device menu.

Select the DVD drive containing the Windows 10 OS DVD and press <Enter>.
Press a key at system startup to begin installing Windows from your Microsoft
Windows 10 disc.

Click Next > Install Now to continue installing the operating system as normal
(see your Windows documentation if you need help on installing the Windows
0S).

Select Custom: Install Windows only (advanced).

It is recommended that you select and then delete existing partitions.

Click New to create a partition for Windows.

It is very important to make sure that when you create the partition, to leave at
least a minimum of unallocated space of 5SMB (see sidebar).

Follow the on-screen instructions to install the Windows 10 operating system.
Install the Windows drivers from the Device Drivers & Utilities + User’s Manual
disc as per Table 4 - 1, on page 4 - 4 (make sure you install the Intel Rapid
Storage Technology driver - see overleaf).

Run the Intel® Rapid Storage Technology application to manage your Intel®
Optane™ system as instructed in “Intel® Rapid Storage Technology for
Optane Systems” on page 6 - 22.

Creating a Windows
Partition for Optane

When installing Win-
dows, make sure that
you leave a minimum of
5MB of unallocated
space for the Intel® Op-
tane™ software to cre-
ate needed metadata.

After you have created a
Windows partition the
Windows Setup screen
will display the partitions
and sizes, including the
unallocated space. If the
unallocated space is
less than 5MB, then de-
lete the partitions and
recreate them until the
criteria is met.

Note this is 5MB only,
not GB.

Setting Up SATA Mode (Optane™ or AHCI) 6 - 5
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25. After installing the Intel® Rapid Storage Technology application you can access
Device Manager (right-click the Start menu and select Device Manager).
26. Click Disk drives to check the Optane drive.

Figure6- 3
Device Manager
(Disk drives)
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Clearing Intel® Optane™

If you wish to clear an existing Intel® Optane™ setup then follow the procedure be-
low to do so. However backup up any necessary files and data before clearing an
Intel® Optane™ setup, as doing so will result in the loss of all data on the volumes.

1. Make sure that Intel® Optane™ is Enabled in the Intel® Rapid Storage Tech-
nology application.

2. Start-up your computer and press <F2> to enter the BIOS.

3. GotoIntel(R) Rapid Storage Technology (in the Advanced menu) and press
<Enter>.

4. Select Intel Optane, **** (listed under Optane Volume:) and press <Enter>.

Aptio Setup Utility — Copyright (C) 2017 American Megatrends Inc.

Figure6- 4
Intel(R) Rapid
Storage Technology
(Advanced Menu)

p Intel Optane, ***kkiid

.|
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5. Select “Deconcatentate” and press <Enter>.

Aptio Setup Utility — Copyright (C) 2017 American Megatrends Inc.

p Deconcatentate

Figure6-5
Intel(R) Rapid
Storage Technology
(Deconcatentate)

6. Select Yes from the “Are you sure you want to perform deconcatentation”
option.
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7. Select “Start deconcatentation” and press <Enter>.

Aptio Setup Utility — Copyright (C) 2017 American Megatrends Inc.

Are you sure you want to perform
deconcatenation?

Figure6-6
Intel(R) Rapid
Storage Technology
(Start
Deconcatentation)

8. The system will return to the standard Intel(R) Rapid Storage Technology menu
when complete (see Figure 6 - 2 on page 6 - 4).

9. You should then select the appropriate SATA Mode for your system and reinstall
the OS.

.|
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i~ Wireless LAN Module

_ . If you have included an Intel® or Qualcomm Ather os (Combo) moduleison (i.e.
Wireless Device . . . . . .
OperatibnAboard the system is not in Airplane M ode) before installing the driver.
Alferat Make sure you install the driversin the order indicated in Table 4 - 1, on page 4 - 4.
The use of any portable
electronic transmission Note that you need to install both the WLAN & Bluetooth drivers for the WLAN

devices aboard aircraft & Bluetooth Combo modules.
is usually prohibited.

VELEERGER BN See the appropriate driver installation instructions on the page indicated below:
Srlg(gi(;tl? yOLT ;rzuljsi(nsé * See“Intel® WLAN Driver Installation” on page 6 - 11.
DRl ©  See “ Qualcomm Atheros WLAN Combo Driver Installation” on page 6 - 11.
aircraft by putting the

system in to Airplane

Mode (see

).
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Intel® WLAN Driver Installation

1. Makesurethesystemisnotin Airplane Mode, and theninsert the Device
Drivers & Utilities + User’s Manual disc into an attached DVD drive.
Click Option Drivers (button).

Click 1.Install WLAN Driver > Yes.

CIickliln the check box to agree to the End User License Agreement and click
Install.

Click Finish.
The operating system is the default setting for Wireless LAN control in

Windows (see page 6 - 12).

OO AWN

Qualcomm Atheros WLAN Combo Driver Installation

1. Makesurethesystemisnotin Airplane Mode, and then insert the Device
Drivers & Utilities+ User’s Manual disc into the DVD drive.

Click Option Drivers (button).

Click 1.Install WLAN Driver > Yes.

Select the language preferred and click Next.

Click Next > Next.

Click in the check box to accept to the License Agreement and click Next.
Click Finish.

Click Yesto restart the computer.

The operating system is the default setting for Wireless LAN control in
Windows (see page 6 - 12).

©oOoNOUA~WN
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WLAN Configuration in Windows 10

Y ou can configure a wireless connection using one of the following options, how-
ever make sure the Wireless LAN module is turned on (and not in Airplane Mode)
before configuration begins.

1
2.
3.
4

Figure6-7
WiFi & Network
Connections

Click the Wireless icon u in the notification area of the taskbar.

Make sure that Airplane mode is off (the Airplane mode icon should be gray).
A list of available access points will appear.

Double-click an access point to connect to it (or click it and click Connect).
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5. Enter a network security key (password) if required, and click Next.

6. You can choose to share or connect to devices or not.

7. When you are connected to the network access point it will display Connected
status .

8. Select any connected network and click Disconnect to disconnect

from a connected access point.
\ A/
Z &

Wireless Device
Operation Aboard Aircraft a
The use of any portable electronic

transmission devices aboard aircraft is
usually prohibited.

Figure6- 8
Make sure the module is either OFF or Network Connected
in Airplane mode if you are using the (Click Disconnect)

computer aboard aircraft.
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9. You can click the Airplane Mode button to turn the mode On or Off.

10. You need to either use Airplane Mode, or to turn the WLAN module off aboard
aircraft.

11. If you click on Network Settings to bring up Network & Internet for a more
comprehensive list of network and internet settings including Wi-Fi (can be turned
on/off), Airplane mode (Airplane mode and Wireless devices can be turned on/off)
VPN, Dial-up, Ethernet and Proxy.

12. You can also access the Network & Internet settings from the Start Menu
(Settings > Network & Internet).

Figure6-9
Network & Internet
Settings
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Bluetooth & WLAN Combo Module

If your purchase option includes the Combination Wireless LAN & Bluetooth T e
module (either Intel® or Qualcomm Atheros) then install the driver as instructed OperatibnAboard
on the following pages. Aircraft

Make sure that the module ison (i.e. the system isnot in Airplane Mode) beforein- SRy A sl iE bl

stalling the driver electronic  transmission
' devices aboard aircraft

is usually prohibited.
Make sure the WLAN &
Bluetooth module(s)
are OFF if you are using
the computer aboard
aircraft by putting the
system in to Airplane
Mode (see

4

Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported

in one direction only (simultaneous data transfer is not supported). Therefore if you are copying
a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from
the Bluetooth enabled device to your computer until the file transfer process from the computer
has been completed.

).

Note that you need to install both the WLAN & Bluetooth drivers for the WLAN
& Bluetooth Combo modules.

Bluetooth & WLAN Combo Module 6 - 15
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Intel Bluetooth Combo Driver Installation

1. Makesurethesystemisnotin Airplane Mode, and then insert the Device
Drivers & Utilities + User’s Manual disc into an attached DVD drive.
Click Option Drivers (button).

Click 2.Install Combo BT Driver > Yes.

Click Next > Next.

Click in the check box to accept the license and click Next.

Select the setup type (Typical is recommended) and click Install.

Click Finish.

See “ Bluetooth Configuration in Windows” on page 6 - 17 for configura-
tion instructions.

ONOOUAWDN

Qualcomm Atheros Bluetooth Combo Driver Installation

1. Makesurethesystemisnotin Airplane Mode, and then insert the Device
Drivers & Utilities+ User’s Manual disc into an attached DVD drive.
Click Option Drivers (button).

Click 2.Install Combo BT Driver > Yes.

Click Next > Next.

Click Install.

Click Finish.

Click Yesto restart the computer.

See “ Bluetooth Configuration in Windows” on page 6 - 17 for configura-
tion instructions.

ONOOUAWN

. |
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Bluetooth Configuration in Windows

1. Click the Settings item in the Start Menu and then click Devices (or click the Blue-
toothicon  in the taskbar and click Add a Bluetooth Device).
2. Click Bluetooth and make sure Bluetooth is On and a list of discovered devices

will appear.

Figure6 - 10
Devices > Bluetooth
Bluetooth Taskbar
Menu
3. Double-click the device you want to pair with the computer and click Pair.
4. On first connection the computer will provide you with a pairing code to be entered
onto the device.
Figure6- 11

Enter the Passcode

. |
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5. Enter the code into your Bluetooth enabled device and click Yes on the computer

to complete the pairing.
6. Select a device and click Remove Device Remove device to disconnect from

any device.

Figure6 - 12
Devices > Bluetooth
Remove Device
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To Make your Computer Discoverable to Bluetooth Devices

1. Click the Settings item in the Start Menu and then click Devices.

2. Click Bluetooth and under Related Settings click More Bluetooth options (or
click the Bluetooth icon  in the taskbar Open Settings).

3. InBluetooth Settings make sure that Allow Bluetooth devices to find this PC
check box (Discovery) has a check inside it.

4. Make sure that the Alert me when a new Bluetooth device wants to connect
check box (Notifications) has a check inside it, if you want to be notified when a
Bluetooth device wants to connect.

Figure6 - 13
Bluetooth Settings
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Intel® Software Guard Extensions Driver

Install the Intel® Software Guard Extensions Driver which provides a set of in-
structions allowing user-level code adegree of security, and privacy, from the oper-
ating system.

Intel SGX Driver Installation

Make sure you have enabled Software Guard Extensions from Advanced Chipset
Control in the Advanced Menu in the BIOS before installing the driver (see “ Soft-
ware Guard Extensions (Advanced Menu > Advanced Chipset Control)” on
page5 - 9).

1. Insert the Device Drivers & Utilities+ User’s Manual disc into an attached
DVD drive.

Click Option Drivers (button).

Click 3.Install Intel SGX Driver > Yes.

Click Next.

Click in the check box to accept the license and click Next.

Click Next > Install

Click Finish to complete the installation.

Noak~wh

. |
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Intel® Rapid Storage Technology

The Intel® Rapid Storage Technology driver supports your AHCI mode SATA
drive, or your Intel® Optane™ system. Install the Intel Rapid Storage Technolo-
gy application (after installing all necessary driversin the correct order) to support
your Optane system or SATA driveif set upin AHCI modeinthe BIOS (see“ SA- AR UEE I CR Tl

TA Mode (Advanced Menu)” on page5 - 10). igggs o SJ:;Z?? ',(\)AQ_DZ’

. . SSDs with a PCl-e In-
IRST Driver Installation terface (M.2 SSDs with

1. Insert the Device Drivers & Utilities + User’sManual disc into an attached :u;g:téd)'_merface =
DVD drive.

Click Option Drivers (button).

Click 4.Install IRST Driver > Yes.

Click Next > Next.

Click in the check box to accept the license and click Next.

Click Next > Next > Next.

Click Finish to restart the computer.

Run the Intel® Rapid Storage Technology app from the Apps screen.

After setting the SATA modeto Intel® Optane™ and installing the Intel® Rapid
Storage Technology application, DO NOT uninstall the Intel® Rapid Storage
Technology application.

IRST and M.2 PCl-e
SSDs

NGO A~WN
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Intel® Rapid Storage Technology for Optane Systems

Intel® Rapid Storage Technology application displays status information on your
Intel® Optane™ configuration. Run the Intel® Rapid Storage Technology appli-
cation from theitem in the Start menu.

When the Intel® Rapid Storage Technology application is launched the system
will open the Status window. Here you can view the general health of the storage
system. Various volume creation and management options are available depending
on the system’ s status.

Figure6- 14
Intel® Rapid
Storage Technology
Status

.|
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Enabling Intel® Optane™

1. Runthe Intel® Rapid Storage Technology application.
2. Click Enable.

Figure6 - 15
IRST - Intel®
Optane™ Memory
(Enable)

Enable

3. The system will pop-up a message and ask you to select a compatible fast drive
(in this case there should only be one option).

Figure6 - 16
IRST - Intel®
Enable Optane™
Memory
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4. You will need to restart the computer after enabling Optane, and make sure the

system is powered by the powered AC/DC adapter, and not by battery only.

Click Yes to begin the process (this may take some time).

After the process has been completed restart the computer.

7. After restarting can access Device Manager (right-click the Start menu and select
Device Manager).

8. Click Disk drives to check that the drive should read Intel Optane ******,

oo

Figure6 - 17
Device Manager

(Disk drives)
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9. Runthe Intel® Rapid Storage Technology application to check the status.

Figure6- 18
IRST - Intel®
Optane™ Memory
(Enabled)
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Disabling Intel® Optane™

\ A/
ﬂ‘ If you need to disable Intel® Optane™ for any reason follow these instructions.
Disabling Intel®
Optane™

1. Runthe Intel® Rapid Storage Technology application.
2. Click Disable.

Disable Intel® Op-

tane™ if you want to

reinstall/reset the sys-

tem or update the

IRST driver. See also

Figure6- 19
IRST - Intel® —
Optane™ Memory N
(Disable) C)
3. Click Yes when the message pops up.
Figure6 - 20

IRST - Yes to
Disable D
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Restart the computer to complete the process.

Run the Intel® Rapid Storage Technology application.

The Status of Intel® Optane™ Memory is indicated in the Window.

To enable Intel® Optane™ Memory follow the process indicated in “Enabling
Intel® Optane™” on page 6 - 23.

Intel® Rapid Storage Technology 6 - 27

HDDs & Intel®
Optane™ SSDs

Note that if your sys-
tem's HDD or Intel®
Optane™ SSD is to be
transferred to another
system for use for any
reason, you will need
to disable Intel® Op-
tane™ in IRST first.

Removal of any cov-
er(s) and /or screw(s)
violates the terms of
your warranty.

Figure6 - 21
IRST - Intel®
Optane™ Memory
(Status)
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Sound Blaster Audio

Install the Sound Blaster AP to allow you to configure the audio settings to your
requirements for the best performance in games, music and movies.

Sound Blaster X-Fi MB-5 Audio AP Installation

1.

OOk wWN

Insert the Device Drivers & Utilities + User’s Manual disc an attached
DVD drive.

Click Option Drivers (button).

Click 5.Install SBX-Fi MB5AP > Yes.

Click Yesto accept the license agreement terms.

Click Next > Full Installation (button).

Click Next > Finish to restart the computer.

Run the Sound Blaster X-FI MB5 control panel from the notification area of the
taskbar (or from the item in the Start menu). Click on the tabs to access the any of
the control panel menus.

Figure6 - 22
Sound Blaster X-Fi
MB5
(Taskbar
Notification Area
Icon)

. |
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Profile

Y ou can setup a Profile with your audio preference settings and choose to save the
settingsfor Music, Movieor different Game Types. These settings can be exported
or imported as required, and custom Profiles may be set and saved as required.

Figure6 - 23
Sound Blaster X-Fi
MB5 Profile

. |
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SBX Pro Studio
Click the dlider button under the control to enable/disable the control, and click the
Smart Volume yellow dlider to adjust the levels. Press the play button &l to test settings.

Setting

The default setting for
Smart Volume in SBX
Pro Studio is set to
Normal.

To get the full effect of
this setting it is recom-
mended that you set it to
Loud.

Figure6- 24
Sound Blaster X-Fi
MB5 SBX Pro Studio

» Surround: Provides virtual sound channelsto control the level of immersion.

» Crystalizer: Enhances audio to make it sound livelier.

» Bass: Enhances the bass level of the sound system.

» Dialog Plus: Enhances dialogue levels for movies etc.

* Smart Volume: Minimizes sudden volume changes to avoid the need for con-
stant adjustment. It is recommended that thisis set to L oud (see sidebar).

6 - 30 Sound Blaster Audio



Modules

Scout Mode
Click on the power button to enable Scout M ode to enhance your ability to hear
enemies in games from afurther distance away than would normally be possible.

Figure6 - 25

Sound Blaster X-Fi
MB5 Scout Mode a
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Voice FX

Click on the power button to enable Voice FX and click on the sliders to adjust
the settings. Select the mode required from the dropbox, and click on Test to hear
the playback of the effect.

Figure 6 - 26

Sound Blaster X-Fi
b MB5 Voice FX
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EAX Effects & EQ

Click to select either/or EAX Effectsor EQ, select the mode required from the drop-
box and click on the slidersto adjust the settings. Click on Save to save any custom
changesto the set levels and effects.

Figure6 - 27
Sound Blaster X-Fi
MB5 EAX Effects &

EQ

. |
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Figure6 - 28
Sound Blaster X-Fi
MB5 Advanced
Settings

Advanced Settings

Click on SPEAKERS/HEADPHONES, select the speaker/headphone configura-
tion from the dropbox, and click on Test to hear the effect. Y ou can aso adjust the
Bass Management by clicking the Bass Redirection and Subwoofer Gain, and
click on the slider to adjust the Crossover Frequency. Click SPEAKER CALI-
BRATION to calibrate the distance and level of the speakers.
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Hot Key Configuration

Click Configure Hot Keys in Scout Mode to access the Hot Key Configuration
menu. Click Enable All Hot K eys, and then click on the task and press the key se-
guence required. Any hotkeys chosen will be locked by the application, and there-
fore will not be able to be used in other applications.

Figure6 - 29
Sound Blaster X-Fi
MB5 Hot Key
Configuration

. |
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Creative ALchemy

The Creative AL chemy application can be run from the shortcut in the Start menu.
Use the left menu to select any installed games and click the button to move them to
the right column to enable ALchemy support for the game. Creative ALchemy re-
stores hardware accelerated audio to enable EAX effects and 3D Audio when play-
ing Direct Sound3D games.

Creative Software AutoUpdate

Run the application from the shortcut in the Start menu and make sure you are con-
nected to the internet, then click Next and follow the on screen instructionsto update
the software.

Sound Blaster Audio & HDMI/Display Port

1. When you connect a display to the HDMI-Out port, or Display Port the Sound
Blaster Cinema controls will be disabled.

2. A warning box will pop-up and will prompt “...Do you want to select another
audio device now?”.

3. Click No to continue using the audio output from your external display attached to
the HDMI-Out port, or Display Port (do not attempt to select another audio device
when connected to the external display).
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Testing 5.1 Surround Sound (Advanced Settings)

If you are using the Sound Blaster X-Fi MB5 control panel (Advanced Settings)
to test your headphones/speakers, set up asa5.1 surround sound system with the mi-
crophone jack enabled as the "Center/Subwoofer" (see Figure 2 - 3 on page 2 - 5)
inthe Realtek HD Audio Manager, you may not hear the low Subwoofer test tone
as some headphones/speakers do not support low frequencies.

If your headphones/speakers do not support low frequencies then follow the instruc-
tions below to obtain an effective sound test.
1. Attach your headphones/speakers to the headphone out jack. a

2. Run the Sound Blaster X-Fi MB5 control panel from the naotification area of the
taskbar (or from the item in the Start screen).

3. Click ADVANCED SETTINGS > SPEAKERS/HEADPHONES.

4. Select 5.1 Surround under Speakers/Headphones Configuration. .

5. Click to place checks in the Bass Redirection/Subwoofer Gain check boxes. Figure6 - 30

6. Move the slider for Crossover Frequency to its maximum setting. Bass Management

7. Click Test to hear the sound. Sound Blaster X-Fi

8. Your headphones/speakers will now be configured for 5.1 Surround. MBSSAd_vanced
ettings
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PC Camera

Use the Fn + F10 key combination (see “ Function Keys & Visual Indicators’ on
page 1 - 13) or Control Center button to toggle power to the PC Camera module.

When the PC Camera s in use the LED indicator to the left of the camera will be
illuminated (sce @ Figure 1 - 2 on page 1 - 6).

Note that you need to use the Camer a app [[@] in Windowsto take pictures and cap-
ture video.

. |
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Camera App

1. Make sure the PC Camera is turned on by using the Fn + F10 key combination (or
Control Center button).

2. Runthe Camera app from the Start menu by clicking on the Camera app icon @
(you can type “camera” into the search box to find the Camera app if it is not
pinned to the Start menu).

3. The interface displays two buttons on the right of the screen; one for photo and
one for video.

Figure6 - 31 a
Camera App Mode

Icons
Photo Video
4. Simply click on the appropriate button to switch to either photo or video modes.
5. You can use the buttons at the top to access the Photo collection, Self Timer or
Settings.
Figure6 - 32

Camera Menu Bar

. |
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6. Click Settings Bl to access the camera settings menu to make adjustments for
Camera Button long key press function, Photo Aspect ratio, Framing grid,
video recording frame rates, Flicker reduction and Digital video stabilization.

4

Camera Settings

The Self Timer may be set to take Photos after 2, 5 or 10 sec-
onds and can also be set to continue taking pictures until the
camera button is pressed again.

b Figure 6-33 The Aspect Ratio can be changed to those supported by the
Camera Settings system.

You can use a Framing grid to help you line up pictures.

The Video recording resolution and frame rate can be set to
any supported by the system. Note that capturing high resolu-
tion video files requires a substantial amount of disk space for
each file. After recording video, check the video file size (right-
click the file and select Properties) and the remaining free space
on your hard disk (go to File Explorer, right-click the hard disk,
and select Properties). If necessary you can remove the record-
ed video file to a removable medium e.g. CD, DVD or USB Flash
drive.

If you need to reduce any screen flicker, change the settings in
Flicker reduction to either e.g. 50Hz or 60Hz.
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Taking Pictures/Capturing Video

1. Make sure the PC Camera is turned on by using the Fn + F10 key combination (or
Control Center button).

2. Runthe Camera app from the Start menu by clicking on the Camera app icon @
(you can type “camera” into the search box to find the Camera app if it is not
pinned to the Start menu).

3. Click to select either photo orvideo modes.

4. Click the photo icon to take a picture, and the camera icon will briefly turn yellow as
the picture is taken.

5. Click on the video icon to start video capture (if video capture begins a timer
will appear at the bottom of the screen and the icon will turn yellow). a

6. To stop video capture click the video icon again.

Figure6 - 34
Video Camera
Recording in
Process
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7. Captured photos and videos will be saved to the Photos app stored in the Start
menu (type Photos into the search box if you cannot find the app).

b Figure6 - 35

Photo App
(For Captured
Photos & Videos)
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Trusted Platform Module

(Optional)

The TPM security chip allowsyou to create and manage digital certificatesfor user
and platform authentication. This type of security is usually administered within
large enterprises and organi zations, and therefore requires implementation by a sys-
tem administrator before users can access security features.

Individual users can use the TPM as an authentication with the fingerprint reader.

Make sure you have administrator’ s rights to your computer, and have a Windows
password enabled for full security protection. In addition Make sure you prepare
aremovablemedia (e.g. aUSB flash drive) to store passwor dsetc. befor e begin-
ning the TPM initialization process.

Before setting up the TPM functions you must initialize the security platform.
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Enabling & Managing TPM

Restart the computer.

Enter the Aptio Setup Utility pressing F2 during the POST/startup.

Use the arrow keys to select the Security menu.

Select TPM Configuration and press Enter to access the sub-menu.

Press Enter under Security Device Support menu and select Enable.

You will then need to press F4 to save the changes and restart the computer.
You can now manage the TPM from Windows.

4

Clearing TPM
Information

You can select Pend-

ing operation, and
then select TPM clear
to clear existing TPM
information in order to
reset the TPM.

Noogoh,whNE

Aptio Setup Utility — Copyright (C) 2016 American Megatrends Inc.

Security Device Support [Enable]

Figure 6 - 36
TPM State (Enable)

. |
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TPM Management in Windows
Y ou can manage your TPM settings from within Windows:

1. Go tothe Control Panel.
2. Click BitLocker Drive Encryption (System and Security).
3. Click TPM Administration.

Figure6 - 37 a

BitLocker Drive
Encryption
(TPM
Administration)
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4. The TPM Management window allows you to configure the TPM within Windows.
As TPM is usually administered within large enterprises and organizations, your
system administrator will need to assist you in managing the information here.

b Figure6 - 38

Trusted Platform
Module (TPM)
Management on
Local Computer
Administration
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TPM Actions

1. Click Prepare the TPM and follow the instructions in the Wizard to prepare the
TPM (this will probably require a restart of the computer and confirmation of the
setting changes after restart by pressing the appropriate F key).

2. After the restart the TPM will be prepared and you can then use the Actions menu
to Turn TPM off, Change Owner Password, Clear TPM or Reset TPM Lockout.

3. A wizard will help take you through any setup steps.

Figure6 - 39
TPM Actions Menu

. |
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BitLocker

BitLocker Drive Encryption can be used in conjunction with the TPM to encrypt
data on the disk. Access the Microsoft BitL ocker Drive Encryption control panel
applet from the Windows control panel (System and Security).

1. Click Turn on Bit Locker.
2. Follow the on-screen instructions to setup BitLocker, and make sure you have a
removable media (e.g. a USB flash drive) to store saved recovery keys etc.

Figure6 - 40
BitLocker Drive
Encryption

. |
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3G/4G Module

If you have included an optional UM T S/HSPA+ based 3G Module (Universal Mo- Wirelese Device
bile Telecommunications System or High Speed Packet Access) module or LTE OperatibnAboard
(Long Term Evolution) 4G module (see“ Communication” on page D - 3 for spec- Aircraft
!flcatlon' details) in your purchase opti on, you do. not require a drlver/appllcatlon The use of any portable
installation for Windows 10. Follow the instructions overleaf to install the USIM  BEEEEEEERE e
card (which will be provided by your service provider), and then use the Charms B EEVEES S0l e e
Bar Wirelessicon to accessthe 3G/4G networ k inthe same manner asthe WLAN.  BEEEEE VAR clellIsEles
Make sure the WLAN,
sy Bluetooth and 3G/4G
7£l§ module(s) are OFF (or
Important Notice the system is in Air-
plane Mode) if you are
using the computer
aboard aircraft (see

If your purchase option includes both Wireless LAN and 3G/4G modules, then the appro-
priate antennas will be installed. Note that In order to comply with FCC RF exposure com-
pliance requirements, the antenna must not be co-located or operate in conjunction with
any other antenna or transmitter.

Important Notice - 3G/4G & Bluetooth/Wireless LAN Modules

).

In order to comply with FCC regulations you should NOT operate the 3G/4G module and
the Bluetooth/Wireless LAN modules at the same time as this may disrupt radio frequency,
and cause interference. When the 3G/4G module is powered on, make sure that the Blue-
tooth/Wireless LAN modules are powered off.
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Insert the USIM card @ asillustrated below (pay careful attention to the orientation
USIM Card of the card as the gold contact side of the card should face downwards) until it clicks
Orientation fully into position. To gject the card simply pressit until it gects, but do not attempt
to gect the card while connected to a 3G/4G network (see below).

Note that the USIM
card’s readable side
(with the gold-colored
contacts) should face
downwards as illustrat-
ed.

Figure6- 41
USIM Card Insertion

USIM Card Ejection

Simply press on the USIM card to eject it, however do not do this while a connection is in
progress.

If you do eject the card while a 3G/4G connection is ongoing, you will need to shut down
the system, reinsert the USIM card, restart the system and then reestablish the 3G/4G con-
nection.

If you wish to change USIM cards then you will need to shut the system down, reinsert the
USIM card, restart the system and then reestablish the 3G/4G connection.
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3G/4G Configuration in Windows 10
Y ou can configure a 3G/4G connection as below, however make sure the system is

not in Airplane Mode before configuration begins. Y ou can connect to a 3G/4G con- Connecting to the
nection in much the same way as the WLAN connection. Ce”:\*ﬂ'ar Nelfwo”‘
) . . . . el
1. Click the Settings item in the Start Menu and then click Network and Internet.
2. Click Cellular a list of available access points will appear. Usually the Internet
3. Click the access point and click Connect. QPN (Access  Point
4. The system will connect to your network. Sl 9 S31 AT
. . cally, however if your
5. Connected will appear under the connection. )
v h he i d load i . cellular data connection
6. You can then access the internet, download e-mail etc. as per any internet isn't working, you should
connection. _ S try manually entering a
7. To disconnect you can select the connection and click Disconnect. new Internet APN based
8. You need to use Airplane Mode aboard aircraft. on your location and
9. You can also click the Wireless icon - in the notification area of the taskbar, click mobile operator. See
Cellular and double-click an access point connect to access the connection Page for details.
information.
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Troubleshooting

Chapter 7: Troubleshooting

Overview

Should you have any problemswith your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’'t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautionsin the preface.
If al elsefails, talk to your service representative. Y ou should also make a record of what happened and what
remedies you tried.

Of course, if something goeswrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you' ve tried everything, and the system still won't cooperate, try turning it off
for afew minutes and then rebooting. Y ou will lose any unsaved data, but it may start working again. Then call
your service representative.

. |
Overview 7 - 1



Troubleshooting

Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working.

Power - Isthe computer actually plugged into aworking electrical outlet? If plugged into apower strip,
make sure it is actually working. Check the LED Power Indicators(see“LCD Panel Open” on page 1 - 6)
to see the computer’s power status.

Connections - Check al the cables to make sure that there are no loose connections anywhere.

Power Savings - Make sure that the system is not in Hiber nate or Sleep mode by pressing the keys config-
ured in your Power Options (see “ Configuring the Power Buttons’ on page 3 - 9), the Fn + F12 key com-
bination, or power button to wake-up the system.

Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
ness (see Table 1 - 3, on page 1 - 13).

Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

Boot Drive - Make sure there are no optical media and/or USB stor age devicesin any connected drive.

.|
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Backup and General Maintenance

» Always backup your important data, and keep copies of your OS and programs safe, but close to hand.
Don't forget to note the serial numbersif you are storing them out of their original cases, e.g. inaCD wal-
let.

* Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with
your OS, or buy the more powerful dedicated programs to do so.

» Write down your passwords and keep them safe (away from your computer). Thisis especially important if
you choose to use a Boot password for the SCU (see“” on page5 - 9).

» Keep copies of vital settings files such as network, dialup settings, mail settings etc. (even if just brief
notes).

SN
L&

Bottom Cover Removal Warning

Users should not remove any cover(s) and /or screw(s) for the purposes of device upgrade as this may violate the terms of
your warranty. If you need to replace/remove the hard disk/RAM/optical device etc., for any reason, please contact your dis-

tributor/supplier for further information.
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Viruses

» Ingtal an Anti-Virus program and keep the definitionsfile (the file which tells your program which viruses
to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tionsfile updates are usually downloadable directly from the internet.

» Becareful when opening e-mail from sources you don’'t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

» Keepa“Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic
information which allows you to startup your computer) handy. You may refer to your OS's documentation
for instructions on how to make one, and many Anti-Virus programs will also provide such adisk (or at
least instructions on how to make one).
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Upgrading and Adding New Hardware/Software

* Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are
doing, otherwise you will risk severely damaging your system.

» Don't open your computer or undertake any repair or upgrade work if as this may violate the terms of your
warranty.

* Read the documentation. We can assume, since you are reading this that you are looking at the computer’s
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by
the installation of new hardware and/or software. Always refer to the documentation of any new hardware
and/or software, and pay particular attention to files entitted “READ ME” or “READ ME FIRST”.

* Wheninstalling a new device always make sure the device is powered on, and in many cases you will need
to restart the computer. Always check that all the cables are correctly connected.

* Make sureyou haveinstalled the driversfor any new hardware you have installed (latest driver filesare
usually available to download from vendor’s websites).

» Thoroughly check any recent changes you made to your system as these changes may affect one or more
system components, or software programs. If possible, go back and undo the change you just made and see
if the problem still occurs.

.|
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» Don't over complicate things. The less you have to deal with then the easier the source of the problem may
be found; Example - if your computer has many devices plugged into its ports, and a number of programs
running, then it will be difficult to determine the cause of aproblem. Try disconnecting all of the devices and
restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and
removing devices and restarting where necessary) will often find the source of a problem, although this may
be time consuming.

.|
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Problems and Possible Solutions

Problem Possible Cause - Solution

You turned on the power but it doesn't | Battery missing / incorrectly installed. Check the battery bay, make sure the
work. battery is present and seated properly (the design of the battery only allows it to
go in one way). Make sure there’s nothing interfering with the battery contacts.

The battery LED power indicator ,is | Low Battery. Plug in the DC power source. If the computer doesn’t start up
blinking orange. immediately, turn it off then on again.

You are losing battery power too quickly. | The system is using too much power. If your OS has a Power Options scheme
(see “Power Plans” on page 3 - 5) check its settings. You may also be using a
peripheral device/lUSB device that is drawing a lot of power.

Actual battery operating time is shorter | The battery has not been fully discharged before being recharged. Make sure
than expected. the battery is fully discharged and recharge it completely before reusing (see
“Battery Information” on page 3 - 17).

Power Options have been disabled. Go to the Control Panel in Windows and
re-enable the options.

A peripheral device/lUSB device is consuming a lot of power. Turn off/fremove
the unused device to save power.

. |
Problems and Possible Solutions 7 - 7



Troubleshooting

Problem

Possible Cause - Solution

The computer feels too hot.

Make sure the computer is properly ventilated and the Vent/Fan intakes are not
blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn
it off for an hour. Make sure the computer isn't sitting on a thermal surface (see
“Overheating” on page 1 - 14 & 1 - 19). Make sure you're using the correct
adapter.

Make sure that your notebook is completely powered off before putting it into a
travel bag (or any such container). Putting a notebook which is powered on in a
travel bag may cause the Vent/Fan intakes to be blocked.

The system will not wake up from a
power saving state (Sleep/Hibernate)
on network activity (Wake on LAN) even
though | have plugged in the powered
AC/DC adapter.

Wake on LAN is supported in AC mode only.

When the system enters a power saving state the plugged in AC/DC adapter
should be connected, and should remain connected, in order to allow the
system to wake up on network activity. Unplugging the adapter, and then
plugging it back in again, will not allow the system to wake up on network
activity.

When playing a video in Media Player,
while using a 4K panel, the counting timer
area at the bottom of the screen
appears to be cut off slightly.

The size of text, apps and other items in Settings > System > Display is set to
250%. In this case it is recommended that the setting should be less than
250%.
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Problem Possible Cause - Solution

Nothing appears on screen. The system is in a power saving mode. Toggle the sleep/resume key
combination, Fn + F12 (see “Configuring the Power Buttons” on page 3 - 9).

The screen controls need to be adjusted. Toggle the screen control key
combinations Fn + F8/F9. If you're connected to an external monitor, make sure
it's plugged in and turned on. You should also check the monitor’s own
brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key
combination, Fn + F7. If an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

No image appears on the external | You haven't installed the video driver and configured it appropriately from the
monitor | have plugged in and powered | Control Panel. See Appendix C for instructions on installing and configuring
on. the video driver.

You forget the boot password. If you forget the password, you may have to discharge the battery of the CMOS.
Contact your service representative for help.

\ A/
ZX
Password Warning
If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot

remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
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Problem

Possible Cause - Solution

The sound cannot be heard or the volume
is very low.

The volume might be set too low. Check the volume control in the Volume
Control Panel in the Windows notification area, or use the key combination Fn
+ F5 and F6 (see “Function Keys & Visual Indicators” on page 1 - 13) to
adjust.

Unwelcome numbers appear when typing.

Num Lock is turned ON (see “LED Indicators” on page 1 - 7).

work.

4

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will
detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not

The system freezes or the screen goes
dark.

The system’s power saving features have timed-out. Use the AC/DC adapter,

press the sleep (Fn + F12) key combination, or press the power button if no
LEDs are lit.

The system never goes into a power
saving mode.

Power Options features are not enabled. Go to the Windows Power Options
menu and enable the features you prefer (see “Power-Saving States” on

page 3 - 7). Make sure you have enabled Hibernate mode from the control
panel.
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Problem

Possible Cause - Solution

The computer is off (or in Sleep Mode) but
powered by the AC/DC adapter plugged in
to a working outlet, or by battery with a
capacity above 20%. | have plugged a
device into the powered USB port in
order to charge it, but the device is not
charging.

The port is not powered on. Toggle power to the port using the Fn + power
button combination.

This function may not work with certain external USB compliant devices (check
your device’s documentation). If this is the case, power the computer on and
connect the external USB device in order to charge it.

Note that this function is designed to help charge USB compliant devices, but
is not designed to allow their operation.

The Wireless LAN/Bluetooth modules
cannot be detected.

The modules are off as the computer is in Airplane Mode. Check the LED
indicator s~ to see ifitis in Airplane Mode (see “LED Indicators” on page 1 -
7). Use the Fn + F11 key combination to toggle Airplane Mode on/off (see
Table 1 - 3,0n page 1 - 13).

The PC Camera module cannot be
detected.

The module is off. Press the Fn + F10 key combination in order to enable the
module (see “Function Keys & Visual Indicators” on page 1 - 13). Run the
camera application to view the camera picture.

The Wireless LAN/Bluetooth modules
cannot be configured.

The driver(s) for the module(s) have not been installed. Make sure you have
installed the driver for the appropriate module (see the instructions for the
appropriate module in “Wireless LAN Module” on page6 - 10 and/or
“Bluetooth & WLAN Combo Module” on page 6 - 15).
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Problem

Possible Cause - Solution

A file cannot be copied to/from a

connected Bluetooth device.

The transfer of data between the computer and a Bluetooth enabled device is
supported in one direction only (simultaneous data transfer is not
supported). If you are copying a file from your computer to a Bluetooth enabled
device, you will not be able to copy a file from the Bluetooth enabled device to
your computer until the file transfer process has been completed

The computer is off (or in Sleep Mode) but
powered by the AC/DC adapter plugged in
to a working outlet, or by battery with a
capacity above 20%. | have plugged a
device into the powered USB port in
order to charge it, but the device is not
charging.

The port is not powered on. Toggle power to the port using the Fn + power
button combination.

This function may not work with certain external USB compliant devices (check
your device’s documentation). If this is the case, power the computer on and
connect the external USB device in order to charge it.

Note that this function is designed to help charge USB compliant devices, but
is not designed to allow their operation.

No sound can be heard through an HDMI
connected display.

You have not configured the HDMI See “HDMI Audio

Configuration” on page C - 7.

audio output.

Audio Volume is too low when listening
through headphones.

You have set the Speaker Configuration to 5.1 Speaker. It is recommended that
you set the Speaker Configuration to Stereo (not to 5.1 Speaker) when
listening through headphones in order to maximize audio quality. See “Audio
Features” on page 2 - 4.
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Problem Possible Cause - Solution

The Sound Blaster audio controls don’t | Note that Sound Blaster Audio will be disabled when you are connecting to an
work when the system is connected to an | external display through an HDMI or Mini Display port connection. See “Sound
external display through an HDMI/Mini | Blaster Audio & HDMI/Display Port” on page 6 - 36.

Display cable.

When using a Bluetooth headset the | This is a common issue with Bluetooth headsets. To resolve this issue do the
audio appears to be mono and not | following (you will need to repeat this procedure after every boot up, restart,
stereo. or when the system resumes from hibernation):

Go to the Devices & Printers control panel in Windows.
Double-click the Bluetooth headset.
Click Connect to complete the stereo connection.

Go to the Sound control panel in Windows.

Right-click (in the Playback tab) the Bluetooth Stereo Audio device
(the default device is Headset).

Click Connect to complete the stereo connection.

NEOWDNE
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Problem

Possible Cause - Solution

| have used Update Driver in Device
Manager (Unknown device > Other
Devices) to try and install the Airplane
Mode driver. Windows encountered a
problem in attempting to update the driver,
and a yellow exclamation mark appears
in Device Manager against the Unknown
device.

It is very important that the drivers are installed in the order indicated in Chapter
4 (which is the numbered installation order on the Device Drivers & Utilities +
User’s Manual disc). This issue can occur when drivers are manually installed,
and not in the correct order.

If you have attempted to Update Driver from the Device Manager control panel
and have encountered problems, then use the method below to correct this:

To correct this problem:

4. Gotothe Programs and Features (Programs) control panel in
Windows.

5. Select any installed Airplane Mode driver item (e.g. Insyde Airplane

Mode HID Mini-Driver), and click Uninstall/Change to uninstall the

current driver.

Restart the computer.

7. Insert the Device Drivers & Utilities + User’s Manual disc and click
Install Drivers (button).

8. Double-click the Airplane Driver item in the menu.

9. Follow the instructions to install the correct driver (you will need to
restart the computer as part of the installation process).

o
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Problem Possible Cause - Solution

A file being copied to/from a connected | You may have the Bluetooth control panel (Settings > Devices > Bluetooth)
Bluetooth device appears to be | open. When transferring data between the computer and a Bluetooth enabled
transferring very slowly. device, make sure that the Bluetooth control panel is closed.

\N A/
LS
Bluetooth Control Panel
(Settings > Devices)

Close the Bluetooth control

panel (pictured on the right)
when transferring data be-
tween the computer and a
Bluetooth enabled device.

. |
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Problem Possible Cause - Solution

| can’'t hear any sound from the | You need to enable listening to the microphone in the audio control panel in
microphone in my connected headset, | order to hear any sound through your connected headset as follows:

when trying to test the audio playback.
1. Right-click the volume control icon in the taskbar.
2. Select Recording Devices. '

3. Double-click Microphone and select Listen.
4. Click to put a check in Listen to this device check box.

5. Click Apply.

You can then listen to the playback though the headset for testing.

7. Remember to disable this feature (remove the check from the Listen to
this device check box) otherwise you may hear an echo from the internal

o
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Resolving the “Can’t connect to this network” issue with the 3G/4G Module

1.

2.

If you have issues connecting to the cellular network when you are attempting to use the 3G/4G network then
you may need to manually connect to the Internet access point name (APN).

Usually the Internet APN is set automatically, however if your cellular data connection isn't working, you should
try manually entering a new Internet APN based on your location and mobile operator.

To find your APN settings contact your mobile operator directly (or of you can connect to a WiFi network on your
PC, or have a phone handy, try searching online to find the Internet APN settings for your mobile operator).
See http://windows.microsoft.com/en-us/windows-10/cellular-settings or search the Microsoft website for
"Windows 10 cellular settings".
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Intel® Optane™ Notes

Intel® Optane™ is a combination of a compatible memory device and Intel Rapid Technology software. This
combination is designed to speed up your system performance. However note the following;

* The SATA Mode should be set BEFORE installing an oper ating system, and after you have backed up all
necessary files and data (see sidebar). See “ Setting Up SATA Mode (Optane™ or AHCI)” on page 6 - 2 for
details. Make sure you install the I ntel Rapid Storage Technology application if you have set the SATA
Modeto Intel RST Premium, or to AHCI (see”|RST Driver Installation” on page 6 - 21).

* Itisvery important to make sure that when you create a hard disk drive partition when installing Windows
for an Intel® Optane™ system, that you leave at least aminimum of 5SMB of unallocated space (notethisis
5MB only, not GB).

» After setting the SATA modeto Intel® Optane™ and installing the Intel® Rapid Storage Technol ogy
application, DO NOT uninstall the Intel® Rapid Sorage Technology application.

» If you are reinstalling a system that has previously been setup in Intel RST Premium mode, make sure
you have cleared the Intel Optane Memory (see“ Clearing I ntel® Optane™” on page 6 - 7). If you
haven't cleared the Optane setup you may not find a suitable hard disk drive partition on which to reinstall
an operating system.

» If you need to reinstall an operating system, uninstall the IRST driver/application or swap the hard disk
drive (or Intel® Optane™ SSD) make sure you have cleared the Intel Optane Memory (see“ Clearing
Intel® Optane™” on page 6 - 7).
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Appendix A: Interface (Ports & Jacks)

Overview

The following chapter will give a quick description of the ports & jacks which allow your computer to commu-
nicate with external devices, connect to the internet etc.
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Ports and Jacks

Item

Description

Card Reader

The card reader allows you to use the following digital storage cards:

MMC (MultiMedia Card) / RSMMC
SD (Secure Digital) / Mini SD / SDHC / SDXC

Push the card into the slot and it will appear as a removable device.

SN
2L

Inserting Cards into the Card Reader

Note that the cards should be inserted with the readable side of the card facing upwards.

DC-In Jack

Plug the supplied AC/DC adapter into this jack to power your computer.

HDMI-Out Port

The HDMI-Out (High-Definition Multimedia Interface) port is an audio/video connector
interface for transmitting uncompressed digital streams. This allows you to connect an external
monitor, TV or Flat Panel Display etc. as a display device (see “Attaching Other Displays” on
page C - 28) by means of an HDMI cable. Note HDMI carries both audio and video signals.

Headphone-Out Jack

Headphones or speakers may be connected through this jack. Note: Set your system’s volume
to a reduced level before connecting to this jack.

Microphone-In Jack

Plug an external microphone in to this jack to record on your computer.
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Item

Description

Mini DisplayPort (1.2) 2

Mini DisplayPort (1.4
Ready)1

o
1%

Mini DisplayPort
Cables

When using cables con-
nected to the Mini Dis-

playPort, try to make
sure that the cables
are not bent exces-
sively, as bending the
cables may cause signal
problems.

The Mini DisplayPort is a miniaturized version of the DisplayPort, which is a digital display
interface standard that allows a digital audio/video interconnect, between the computer and its
external display or a home-theater system.

4

Mini Display Ports
Depending on the port being connected to, external displays can be confiqured using either the Intel HD

Graphics control panel, Project menu (press the Windows logo key == on your keyboard and the P
key), Display Settings or NVIDIA Control Panel.

Mini Display Port 1 o; If you wish to configure an external display connected to Mini Display Port 1
you must use Project Menu, Display Settings in Windows (see Figure C - 2 on page C - 6) or the
NVIDIA Control Panel (see “NVIDIA Control Panel” on page C - 31) to adjust the display configura-
tion.

Mini Display Port 2 9: If you wish to configure an external display connected to Mini Display Port 2
you must use the Intel HD Graphics control panel menu to control the display configuration.

Note that this computer supports virtual reality (VR) headsets, however VR headsets must be connect-
ed to Mini Display Port 1 e

See Appendix C for full information on external display configuration.

Figure A - 1 - Left Side View (Mini Display Ports Highlighted)
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Item

Description

RJ-45 LAN Jack

This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

S/PDIF-Out Jack

This S/PDIF (Sony/Philips Digital Interface Format) Out Port allows you to connect your DVD-
capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.

Security Lock Slot

To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.
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Item

Description

USB 3.0(USB3.1Gen1)
Port

3.0
Powered USB 3.0 (USB
3.1 Gen 1) Port

3.0
USB 3.1 (USB 3.1 Genl
Type C) Port
OR
(Factory Option)
USB 3.1 (USB 3.1 Gen 2
Type C) Port

These USB ports are for low-speed peripherals such as keyboards, mice or scanners, and for
high-speed peripherals such as external HDDs, digital video cameras or high-speed scanners
etc. Devices can be plugged into the computer, and unplugged from the computer, without the
need to turn the system off (if the power rating of your USB device is 500mA or above, make sure
you use the power supply which comes with the device).

The USB 3.0 ports capable of 5Gbps (SuperSpeed) are classified as USB 3.1 Gen 1. There are
three or four (factory option dependent) USB 3.0 (USB 3.1 Gen 1) ports on this computer model
(including the powered USB 3.0 port). One new USB 3.1 Gen 2 port (Type C), capable of 10Gbps
(SuperSpeed+) is available as a factory option.

Note the Type C port is the smaller sized USB port.

Note: The powered USB 3.0 port (see Figure 1 - 9 on page 1 - 17) may be toggled on /off by
means of the Fn + Power Button key combination. When the powered USB port is on it will supply
power (for charging devices only, not for operating devices) when the system is off but still
powered by the AC/DC adapter plugged into a working outlet, or powered by the battery with a
capacity level above 20% (this may not work with certain devices - see page 7 - 12).

Note: This function is designed to help charge USB compliant devices, but is not designed to
allow their operation.

Note: The maximum amount of current supplied by USB Type-C ports is 500 mA for USB2.0/900
mA for USB 3.1
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Appendix B: Control Center & Flexikey®

Overview

The following chapter will give aquick description of the functions of the Control Center & Flexikey® appli-
cations.

Control Center

The Control Center givesquick accessto frequently used controls, power management features and enablesyou
to quickly turn modules on/off. Click the Control Center icons to toggle the appropriate function, or hold the
mouse button down and movethe dial control where applicable. Certain functionswill automatically be adjusted
when apower modeisselected. The Control Center in Windows 10 works under the Desktop app and not under
the Start screen.

Flexikey®

The Flexikey® application isaquick hotkey configuration application, which allowsyou to assign asinglekey
to launch multiple key combinations, or to launch programs and applications, to create text macr os and to
disable certain keys. The application can also be used to configur e the mouse buttons to create hotkeys for
gaming etc. All the configuration settings are retained under (up to12) profilesto which the settings are applied.
Click Flexikey® in the Gaming section of the Control Center, or the click the icon in the notification
area of the taskbar, to launch the application.
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4

Control Center Access

To run the Control Center press the Fn + Esc key combination, or double-click the icon in
the notification area of the taskbar. Close the Control Center by clicking the close icon in

the top right of the panel (move the cursor onto the top right corner of the panel to highlight it).

Flexikey® Access

The Flexikey® is accessed from within the Control Center by clicking Flexikey® in the Gam-
ing section of the Control Center.

Figure B - 1 - Control Center & Flexikey®
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Power Modes
Y ou can set a Power M ode by clicking the appropriate icon at the top of the Control Center. Each power
mode will affect the Power Conservation Mode, Airplane Mode, Power Plan and PC camera power etc.

You can click a Control Center icon to set an overall power mode and then click individual iconsin the
Control Center to power on/off the Touchpad and PC camera.

Modes Quiet Power Saving Performance Entertainment
Icon
Power Plan Balanced Power Saver High Performance Balanced
Power Conservation Mode Balance Energy Star Performance Balance
PC Camera ON OFF ON ON
TouchPad ON ON ON ON
Airplane Mode OFF ON OFF OFF

Table B - 1- Power Modes
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Control Center Menus
The Control Center contains 3 menu headings (System Program, Device and Gaming) under the Power
Modes. Click the menu headings and then click any of the buttons outlined on the following pages.

Figure B - 2 - Control Center Menus

. |
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Power Status (System Program)
The Power Statusicon will show whether you are currently powered by the battery, or by the AC/DC adapter
plugged in to aworking power outlet. The power status bar will show the current battery charge state.

Brightness (System Program)
The Brightness icon will show the current screen brightness level. You can use the slider to adjust the screen
brightness or the Fn + F8/F9 key combinations, or use the Fn+ F2 key combination to turn off the LED backlight
(press any key to turn it on again).

Volume (System Program)
The Volume icon will show the current volume level. Y ou can use the slider to adjust the Volume or the Fn +
F5/F6 key combinations, or use the Fn+ F3 key combination to mute the volume.

Fan Speed (System Program)

Y ou can set thefan speed to M aximum (full power), Automatic or Custom from this menu item. The fan speed
will adjust itself automatically to control the heat of the CPU. However you can adjust the setting to maximum
if you prefer. Select Custom and click on the sliders to adjust the settings to your preference, however these set-
tings can be overridden by the system, as a safety precaution, if it requires heavier use of the fan.

4

Custom Settings

Click Save to retain customized settings, or Reset to select default settings.
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Power Conservation (System Program)

This system supports Ener gy Star power

management features that place computers (CPU, hard drive, etc.) into alow-power sleep modes after a desig-
nated period of inactivity (see “ Power Conservation Modes’ on page 3 - 12). Click either the Perfor mance,
Balanced or Power Saving button.

Sleep Button (System Program)
Click either the Hibernate or Sleep buttons to have the computer enter the selected power-saving mode (see
“Power-Saving States’ on page 3 - 7).

Desktop Background (System Program)
Clicking the Desktop Background button will alow you to change the desktop background picture.

Display Switch (System Program)
Click the Display Switch button to access the menu (or use the g + P key combination) and select the appro-
priate attached display mode.

Time Zone (System Program)
Clicking the Time Zone button
will access the Date and Time Windows control panel.

Backlight Keyboard (Device)
Click the number s under the Backlight Keyboard icon to
adjust the brightness of the keyboard backlight LED.

. |
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TouchPad/Camera (Device)

Click either of these buttons

to toggle the TouchPad or camera modul €' s power status. The icon will appear dimmed when it is off. Note that
the power status of the cameramoduleis also effected by the Power M ode selected (see Table B - 1, on page B
- 3).

Caps Lock/Scroll Lock/ Number Lock/Airplane Mode
Click the button to toggle the appropriate lock mode and Airplane Mode.

Left Windows Key (Gaming)

Click Disable to disable the

Windows Key on the | eft side of the keyboard. This may be useful if you are using the gaming keys (W, A, S&
D) and wish to avoid accidentally triggering menus with the Windows Key.

Headphone (Gaming)
The headphones may be set for different effects using this menu.

Flexikey® (Gaming)
Click the button to access the Flexikey® application.
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Flexikey® Application

Click the button in the Control Center, or theclick theicon in the notification area of the taskbar,
to access the Flexikey® application.
Profiles

The menus on the left side of the application relate to Profiles. Y ou can Add or Delete Profiles (you can main-
tain 12 active Profiles), Export and Import profiles from the menus. If you double-click on a Profile you can
change the Profile Name, and change an I mage file (images created using PNG files).

\ A/

L&
Windows Key - &

P Key

Note that you can

assign actions to
any keyboard key
except the Win-
dows key f-and P
key.

Figure B - 3 - Flexikey® - Profiles
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Flexikey® Application Features

« EXPRESSKEY - Thisfeature allowsyou to configure asingle key to send multiple key combinations or to
create more useful shortcut keys. Thisis useful in gaming or when using applications which have a complex
set of keyboard shortcuts.

» LAUNCH APP - Thissimply assigns single keysto launch any program’s or application’s executablefile.
» EXPRESSTEXT - With thisyou can assign single keys to send commonly used strings of text.

* DISABLE - Use thisfunction to disable any keyboard keys.

» STATISTICS - Use thisto quickly record keysin use in any application, and to disable unused keys.

Keyboard and Mouse Settings

Click Enableto create settings for the keyboard and/or mouse by clicking the button on the top left of the screen
(e.g. you may wish to create a profile with settings only for the mouse or keyboard). Clicking on the keyboard
or mouse icons will allow you to access the settings page for the either the keyboard or mouse.

Figure B - 4 - Enable Keyboard & Mouse / Language Selection

Language Interface
Y ou can change the language interface by right-clicking theicon in the notification area of the taskbar and
selecting the language from the menu.

.|
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Enabling or Disabling Flexikey®

Y ou can enable or disable Flexikey® (and therefore any hotkeys or mouse profile functions currently in use) by
using the Fn + Back space key combination. Pressing this key combination will toggle you between the currently
selected keyboard or mouse profile to the standard keyboard and/or mouse settings, and back again.

Figure B - 5 - Enable/Disable Flexikey®
Theicon Flexikey® icon in the notification area of the taskbar will appear grayedout ~ when Flexikey® is off,

andincolor  whenon (anon screeniconwill also pop-up to display the status of the application asitistoggled
on/off).

Flexikey® Enabled

Flexikey® Disabled

Figure B - 6 - Taskbar Notification Area Icons

.|
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Keyboard Settings

The keyboard settings allow you to configure actions for any single key (or a combination of keys). Click the
key and then select the Action Type (Express Key, Launch App, Express Text or Disable) from the menu at
the bottom of the page. Y ou can rename the action by clicking in the Name box, and click in Tool Tipsto type
in anote to remind you of the action’s function.

\ A/

2§
Windows Key - &

P Key

Note that you can
assign actions to

any keyboard key
except the Win-
dows key [f{and P
key.

Figure B - 7 - Key Configuration
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Mouse Settings

When an external mouse is attached, the mouse settings allow you to configure actions for the left @, right @
and middle @ buttons of the attached mouse, and also for any backward @ and forward @ buttonsiif appli-
cable (on a gaming type mouse). Click the button number and then select the Action Type (Express Key,
Launch App, Express Text or Disable) from the menu at the bottom of the page. Y ou can rename the action
by clicking in the Name box, and click in Tool Tipsto typein anote to remind you of the action’s function.

Figure B - 8 - Mouse Configuration

.|
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Keyboard Settings - Express Key
To configure asingle key to send multiple key combinations, or to create more useful shortcut keys, use Express
Key.

1.

2.

Enable and select the keyboard under your chosen profile, click on a key to select it, and then click to select
Express Key in Action Type.

In the following example we want to change an existing game key configuration which uses the left shift key for
sprinting, and the W key for moving forwards, to use the left Ctrl key to combine this movement to sprint
forward.

Click on the chosen key for the shortcut action.

Click in the Tool Tips field and type to give the key combination a name e.g. “Sprint Fwds”, then click back in
the Name field (to avoid adding the recorded keys to the Tool Tips name).

Click Start Record and then press the key or keys (in this case we will press Left Shift and W) required (make
sure you press the key(s) required and do not click on them).

Click Stop Record to complete the process.

Figure B - 9- Express Key Record Key Combination
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7. Click Save to save the settings within your chosen profile.

8. If you want to remove any individual key click to select it, and then click Delete.

9. If you want to clear all the settings click Restore to return to the default key setting.
10. Any assigned Express Keys will appear in orange.

Figure B - 10 - Key Combination Set

4

Tool Tips

The Tool Tips field allows you to type a note to remind yourself of the function you have programmed the key for under
any Profile.
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Enabling Time Record
If you want to create a delay between key presses within the key combination, then you can use Time Record
function to do so.

Enable and select the keyboard under your chosen profile, click to select a key for the shortcut action, and then
click to select Express Key in Action Type.

Click in the Tool Tips field and type to give the key combination a name, then click back in the Name field (to
avoid adding the recorded keys to the Tool Tips name).

Click Start Record and then press the key or keys required in the sequence and time delay between key
presses required (make sure you press the key(s) required and do not click on them).

1.

2.

Click Stop Record.

Control Center & Flexikey®

Click to select a key in the sequence and click Enable Time Record , then click a

key to view the time delay.

Figure B - 11 - Enable Time Record
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6. You can edit the delay between key presses by clicking in the Delay Time (MS) field and typing a new number
for the delay between the key presses.

Figure B - 12 - Time Record Between Key Presses
Click to close the Time Record window.
Click Save to save the settings within your chosen profile.
If you want to remove any individual key click to select it, and then click Delete.
0. If you want to clear all the settings click Restore to return to the default key setting.

B © oo~
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Keyboard Settings - Launch App
Y ou can configure keys to launch any application or program as follows:

1. Enable and select the keyboard under your chosen profile, click to select a key to launch the application, and

then click to select Launch App in Action Type.
2. Click Browse... at the bottom right of the application window.

Figure B - 13 - Keyboard - Launch App (Browse to Executable File)

.|
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3. Navigate to the executable file of the application and click Open.

4. The key will now be configured to open the selected application under your chosen Profile, and the key will
appear in

Figure B - 14 - Key Set to Launch App

5. If you want to remove any Launch App Key, select it and click on Restore.
6. Click Save to save the settings within your chosen profile.

B - 18 Keyboard Settings - Launch App



Control Center & Flexikey®

Keyboard Settings - Express Text

A single key can be set to send a string of text within any application using Express Text.

1. Enable and select the keyboard under your chosen profile, click to select a key, and then click to select Express

Text in Action Type.
2. Click in Start key if required (the Start key is the key used to in your target program to open a text message), or

you can leave it blank if you prefer.
3. Click in the Click to type field and type in your message.

Figure B - 15 - Keyboard - Express Text

.|
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4. Click in Send key if required (the Send key is the key used to in your target program to send a text message e.g
the Enter key would be the most commonly used), or you can leave it blank if you prefer.

5. The key will now be configured to send the text message in the target program under your chosen Profile, and

the key will appear in blue.

If you want to remove any Express Text key, select it and click on Restore.

Click Save to save the settings within your chosen profile.

SN
L&

Copy & Paste Text

N o

Note that some applications and games do not support copy and pasted text. Where this is the case, any text you may have
copy and pasted in to the “Type to Text” field may not be displayed within the application. In this case you will need to type
the text into the field instead.

B - 20 Keyboard Settings - Express Text



Control Center & Flexikey®

Keyboard Settings - Disable
Y ou can use the program to disable any keys not required.

1. Enable and select the keyboard under your chosen profile, click to select a key to disable, and then click to select
Disable in Action Type.

The key will now be disabled.

If you want to enable the key again, select it and click on Restore.

Click Save to save the settings within your chosen profile.

The key will be disabled under your chosen Profile, and the key will appear in Gray.

aprwn

Figure B - 16 - Keyboard - Disable

.|
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Mouse Settings - Express Key

To assign a mouse button click to send multiple key combinations (an external mouse must be attached), or to
create more useful shortcut keys, use Express Key.

1. Enable and select the mouse under your chosen profile, click on a mouse button to select it, and then click to

select Express Key in Action Type.
2. In the following example we will configure the central mouse wheel to combine the actions of left shift key for

sprinting, and the W key for moving forwards in a game program.
3. Click on the central mouse wheel for the shortcut action.

Figure B - 17 - Mouse - Express Key Record Key Combination (Mouse)

.|
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4. Click in the Tool Tips field and type to give the key combination a name e.g. “Sprint Fwds”, then click back in
the Name field (to avoid adding the recorded keys to the Tool Tips nhame).

5. Click Start Record and then press the key or keys (in this case we will press Left Shift and W) required (make
sure you press the key(s) required and do not click on them).

6. Click Stop Record to complete the process.

7. Click Save to save the settings within your chosen profile.

8. If you want to remove any mouse setting click to select it, and then click Delete.

9. If you want to clear all the settings click Restore to return to the default mouse setting.

10. The mouse button for any assigned Express Keys will appear in

Enabling Time Record for Mouse Settings

If you want to create a delay between key presses within the mouse click combination, then you can use Time
Recor d function to do so in the same manner as that used for keyboard settings (see “ Enabling Time Record”
on page B - 15).
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Mouse Settings - Launch App

Y ou can assign a mouse button click to launch any application or program as follows:

1. Enable and select the mouse under your chosen profile, click on a mouse button to select it, and then click to

select Express Key in Action Type.
2. Click Browse... at the bottom right of the application window.

Figure B - 18 - Mouse - Launch App (Browse to Executable File)

.|
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3. Navigate to the executable file of the application and click Open.

4. The mouse click will now be configured to open the selected application under your chosen Profile, and the
button will appear in green

5. Click Save to save the settings within your chosen profile.

Figure B - 19 - Mouse Button Set to Launch App

.|
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Mouse Settings - Express Text
A mouse button click can be set to send a string of text within any application using Express Text.

1. Enable and select the mouse under your chosen profile, click on a mouse button to select it, and then click to

select Express Text in Action Type.
2. Click in Start key if required (the Start key is the key used to in your target program to open a text message), or

you can leave it blank if you prefer.
3. Click in the Text Context field and type in your message.

Figure B - 20 - Mouse - Express Text
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4. Click in Send key if required (the Send key is the key used to in your target program to send a text message e.g
the Enter key would be the most commonly used), or you can leave it blank if you prefer.

5.  The mouse button click will now be configured to send the text message in the target program under your

chosen Profile, and the button will appear in blue.

If you want to remove any Express Text mouse button, select it and click on Restore.

7. Click Save to save the settings within your chosen profile.

o
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Mouse Settings - Disable

Y ou can use the program to disable any mouse button clicks if not required.

1. Enable and select the mouse under your chosen profile, click on a mouse button to select it, and then click to
select Disable in Action Type.

The button click will now be disabled.

If you want to enable the button again, select it and click on Restore.

Click Save to save the settings within your chosen profile.

The button click will be disabled under your chosen Profile, and the key will appear in Gray.

aprwn

Figure B - 21 - Mouse - Disable

.|
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Statistics

The Statisticstab allows you to record keys used in any application, and to disable any infrequently, or unused,
keys to save any accidental incorrect key presses.

1. Click the Statistics Tab, and press Start Record to start recording the frequency of key presses for keys used.

2. You can then go to the application you wish to use the profile for, and use the application as normal so that a
standard set of keys used may be recorded.

3. Return to the Flexikey® application and press Stop Record to stop recording.

4. Atthe end of the recording process colors will represent the frequency of key presses, with red as the most

frequent through to lighter blue the less frequent (the color bar at the bottom of the screen displays the color

code against the number of key presses).

Under Quick Disable click the color which corresponds to the keys you wish to disable.

6. All disabled keys will then change to gray and will be disabled under this profile.

o

Figure B - 22 - Statistics

. |
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Appendix C: Video Driver Controls

Overview

The basic settings for configuring the LCD are outlined in “Video Features’ on
page 1 - 27. The basic video features for this computer can be configured using the
Intel(R) HD GraphicsControl Panel, Windows Display Settingsor NVIDA con-
trol panel.

4

Mini Display Ports

Depending on the port being connected to, external displays can be configured using either
the Intel HD Graphics control panel, Project menu (press the Windows logo key == on
your keyboard and the P key), Display Settings or NVIDIA Control Panel.

Mini Display Port 1 9; If you wish to configure an external display connected to Mini Dis-
play Port 1 you must use Project Menu, Display Settings in Windows (see Figure C - 2
on page C - 6) or the NVIDIA Control Panel (see “NVIDIA Control Panel” on page C -
31) to adjust the display configuration.

Mini Display Port 2 @: If you wish to configure an external display connected to Mini Dis-
play Port 2 you must use the Intel HD Graphics control panel menu to control the display
configuration.

4

Video Card Options

Note that card types,
specifications and driv-
ers are subject to contin-
ual updates and
changes. Check with
your distributor/supplier
for the latest details on
video cards supported.

Overview C - 1
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Microsoft Hybrid Graphics

Most notebook computers come with either a discrete or integrated graphics solu-
tion. Your computer features Microsoft Hybrid Graphics switchable graphics
technology. This seamless technology is designed to get best performance from the
graphics system while alowing longer battery life, without having to manually
change settings. The computer’s operating system (and some applications) will au-
tomatically switch between the integrated UMA (Unified Memory Architecture)
GPU (iGPU) and the discrete GPU (dGPU) when required by the applications in
use. This switch is seamless to the user.

Discrete graphics solutions feature a dedicated Graphics Processing Unit (GPU)
which are capable of playing games, watching HD video or running GPU-based ap-
plications. However computers with discrete graphics solutions tend to be heavy in
power consumption, and slightly larger in size in order to incorporate the dedicated
discrete GPU.

Integrated graphics solutions usually feature memory sharing technology to help
save power consumption and allow for longer battery life. However computers with
integrated graphics solutions will not usually run games, HD video or GPU-based
applications without severe limitations.

C - 2 Microsoft Hybrid Graphics
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How Switchable Technology works

When the system is powered up and is displaying just the desktop, the dGPU will be
powered off. In this case the system is running in the same way as a system without
a discrete graphics solution. However when an application that requires use of the
dGPU isrun (e.g, agame or HD Video), the dGPu is powered on and takes over the
processing duties. If the program is closed, then the dGPU will be powered back
down again until required.

.|
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Video Driver Installation

_ Z Make sure you install the driversin the order indicated in Table 4 - 1, on page 4 - 4.
IGPU or dGPU Insert the Device Drivers & Utilities + User’s Manual disc into an attached DVD
Note the NVIDIA control | driveand click Install Drivers (button).

panel refers to High- .
performance NVIDIA Video (VGA)

srocessng(UW)hichdils the | 1. Click 2.Install VGA Driver > Yes.
iscrete and Inte- .

et GETes (e 2. Cl!ck N_e>§t > Yes> Next > Next.

is the integrated GPU). 3. Click Finish to restart the computer.

NVIDIA Video (VGA)
1. Click 3.Install NVIDIA VGA Driver > Yes.
2. Click AGREE AND CONTINUE (button) to accept the terms of the

license agreement.
3. Click Next.
. 4. Click the Close to complete the installation.
C

. |
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Configure Other Displays Using Project

Y ou can configure attached displays from Proj ect.

1. Attach your display to the appropriate port, and turn it on.

2. Pressthe g + P key combination.

3. Click on any one of the options from the menu to select PC screen only,
Duplicate, Extend or Second screen only.

4. You can also click Connect to a wireless display at the bottom of the Project
screen and follow the steps to connect to any wireless enabled display.

FigureC-1
Project

Configure Other Displays Using Project C - 5
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Configuring an External Display In Windows
The System Control Panel in Settings may also be used to configure displays.

1.
2.

3.

&

FigureC- 2
System > Display

Attach your external display to the appropriate port, and turn it on.

Click the Start Menu and click Settings > System (or right-click the desktop and
select Display Settings).

You can change Duplicate, Extend or choose to display on 1 screen only. under
Multiple Displays.

Click Apply to save any changes made.

Click Advanced display settings to access further options.

.|
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HDMI Audio Configuration

HDMI (High-Definition Multimedia I nterface) carries both audio and video signals. _
In some cases it will be necessary to go to the Sound control panel and manually VIme A RTSmETS
configure the HDM I audio output as per the instructions below. The sound volume level
can be clicking using the
Go to the Sound control panel. volume control icon E]::
Click Playback (tab) in the notification area
The playback device will be selected. of the taskbar.

You may need to select the audio device and click Set Default (button).
Double-click the device to access the control panel tabs.

C o~ FigureC -3
— Sound - HDMI

Device (set Default)

LR

-
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6. Adjust the HDMI settings from the control panel tabs.
7. Click OK to close the Sound control panel.

FigureC-4
HDMI Device
Properties

C - 8 HDMI Audio Configuration
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HDMI Notes
» Connect adevice with HDMI support to the HDMI-Out port BEFORE attempt- A
ing to play e_\udi o/video sources through the de_'vice. Other Applications
» To play audio sources through your external display’s (TV or LCD) speakers . .
you will need to go to the audio configuration control panel on the display and If you are using a third

party application to play
DVDs etc. from any at-
tached DVD device,
you will need to consult

configure the audio input accordingly (see your display device manual).

HDMI Video Configuration

1. Connect an HDMI cable from the HDMI-Out porlt to your extgrnal display. the application’s docu-
2. Configure your external display as per the instructions in “Attaching Other mentation to see the
Displays” on page C - 28. appropriate audio con-
3. Set up your external display (TV or LCD) for HDMI input (see your display device figuration (the applica-
manual). tion must support digital
4. You can now play video/audio sources through your external display. to analog translation).

.|
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4

Compatible
Adapters

For a list of compatible
adapters check the vid-
eo adapter/display de-
vice documentation, or
with  your distributor/
supplier.

Wireless Display

Wireless Display uses your Wireless LAN module/WLAN Bluetooth Combo mod-
ule (you need to make surethat your video adapter/display deviceiscompatible
with your particular WLAN/Combo module) in conjunction with a compatible
video adapter/display device (purchased separately) to allow you to display the
contents of the notebook display on another display (e.g. HDTV), without the need
to have cables stretching across a room.

Y ou can use the wireless display to play games, browse the internet, display videos
or photo slide shows on your TV/external display without using HDMI or A/V ca-
bles.

Before configuring Wireless Display you will need to set up your compatible
adapter with your display/speakers. Connect the adapter usingan HDMI or A/V ca-
ble and turn on the display (or in the case of speakers connect them to the wireless
speaker adapter with the cables provided with the adapter), and then set the display
to the appropriate input channel (see the documentation supplied with your compat-
ible adapter/display for full details).

Note that no driver or application is required for wireless display in Windows 10.

C - 10 HDMI Audio Configuration
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Wireless Display Configuration

1. Note that no driver or application is required for wireless display in Windows 10.

2. Pressthe g@ + P key combination.

3. Click Connect to a wireless display at the bottom of the Project screen and
follow the steps to connect to any wireless enabled display.

FigureC-5
Add a Wireless
Display

4. The system will then search for compatible display devices (this may take up to
60 seconds so allow time for this to complete).
5. Double-click any detected display device in the list.

.|
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6. You may then need to input a pin number for the device to which you are
connecting and click Next.

7. The display will then connect (for specific settings for your display see the
documentation supplied with your compatible adapter/display for full details).

8. Go to the Project menu and click Disconnect to temporarily disconnect from the
wireless display.

9. To permanently disconnect from the display (you will need to go back through the
connection process again) you can select it in Devices and click Remove Device
> Yes.

C - 12 Wireless Display Configuration
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Intel® HD Graphics Control Panel

Advanced video configuration options are provided by the Intel®@ HD Control Pan-
el. To access the control panel see below and overleaf:

1. Right-click the Desktop and select Intel(R) Graphics Settings from the menu.

OR
2. Click the icon in the notification area of the Desktop taskbar and select Intel(R)

Graphics Settings from the menu.

Intel® HD Graphics Control Panel C - 13

FigureC-6
Right-Click Desktop
(Intel Graphics
Settings)

FigureC-7
Taskbar Notification
Area lcon Menu
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OR
3. Double-click the Intel(R) HD Graphics control panel in the Windows Control
Panel.

FigureC-8
Control Panel
Intel® Graphics
Settings

C - 14 Intel® HD Graphics Control Panel
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Y ou may make changes to any of the graphics properties by clicking the appropriate
menu panel and adjusting the settings from the menus. 4

Home

Click the Home button to
return to the main menu
screen in any of the sub-
menu screens.

FigureC-9
Intel® HD Graphics
Control Panel

Intel® HD Graphics Control Panel C - 15
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Display
Z \ Click either Display Settings or Color Settings to make display adjustments, in-
Multiple Display cluding configuration for any attached external displays.
At least one other di§- e m—
play must be attached in N’

order to view multiple
display selection op-
tions.

FigureC- 10
Intel® HD Graphics
Control Panel
Display

C - 16 Intel® HD Graphics Control Panel
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Click the Display menu at the top of the screen to display the sub-menus. The M ul-

tiple Displays menu allows you to configure the display mode of any attached dis- 4

plays (see “ Attaching Other Displays’ on page C - 28). Click Apply to save any Multiple Display

changes made.
At least one other dis-
play must be attached in
order to view multiple
display selection op-
tions.

Audio Settings

Any attached active dis-
plays must have audio
capacity to allow audio
configuration.

FigureC- 11
Intel® HD Graphics
Control Panel
Display - Multiple
Displays

Intel® HD Graphics Control Panel C - 17




Video Driver Controls

The Custom Resolutions sub-menu allows you to adjust the display (or any at-
tached display) to any width, height, refresh rate, color depth and underscan percent-
age of your choice. Note that incorrect settings can cause system instability and even
possible component damage, so thisis adjusted at your own risk.

FigureC - 12
Intel® HD Graphics
Control Panel
Display Settings -
Custom
Resolutions
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3D

This menu allows you to choose how 3D images are displayed. Perfor mance gives
the smoothest motion of images, Quality displays the most detail, Balanced M ode
provides better computer performance with good quality and Custom allows you to
configure the Anisotropic Filtering and Vertical Sync and featuresto your prefer-
ences. Click Apply to save changes.

FigureC- 13
Intel® HD Graphics
Control Panel 3D

.|
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Options and Support
Hot Key Manager in Optionsand Support allowsyou to create hot keysfor open-
ing the application and scaling etc. Click Apply to save changes.

FigureC- 14
Intel® HD Graphics
Control Panel
Options and
Support

C - 20 Intel® HD Graphics Control Panel
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Click the Options menu at the top of the screen to display the sub-menus. The In-
formation Center provides details on System Information, the Built-1n Display Z
and any attached displays. Preferences

Go to the Preferences
sub-menu in Options to
configure the preferences
for the Intel® HD Graphics
Control Panel.

Make sure you click En-
able under Tray Icon to

display the Intel® HD
Graphics Control Panel
icon in the notification area
of the taskbar (as below).

FigureC- 15

Intel® HD Graphics
Control Panel
Options -
Information Center

Intel® HD Graphics Control Panel C - 21
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FigureC- 16
Intel® HD Graphics
Control Panel -
Video
(Color
Enhancement)

Video

The Video menu allows you to brighten or darken movies, or to switch to vivid col-
ors. The Preview image will display a sample image using the current settings. Y ou
can Save Profile and name the Profile to recall the settings at any time. Click Apply

to save changes (select Color Enhancement or Image Enhancement from the
menu).

C - 22 Intel® HD Graphics Control Panel
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Click the Video menu at the top of the screen to display the sub-menus.The Image
Enhancement menu allows you to adjust the Sharpness, Skin Tone Enhance-
ment, Noise Reduction, Contrast Enhancement and Film M ode Detection. Click
Apply to save changes.

Figure C - 17
Intel® HD Graphics
Control Panel - Video
(Image
Enhancement Basic)
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Power
The battery life can be extended through dynamic control of the frame rate if Ex-

tended Battery Life for Gaming is enabled. Settings can be selected for when the
system is powered by battery or is plugged in.

FigureC- 18
Intel® HD Graphics
Control Panel -
Power

C - 24 Intel® HD Graphics Control Panel



Video Driver Controls

Profiles

Y ou can select one of the preset profiles (Brighten Video, Darken Video and En-
hance Video Colors) from the menu on the left. Alternatively you can go through
the menus to make adjustments to your preferences for Display, Color, Video, Op-
tions and Support and Power (tick any boxes for the settings required), and then
Save the settings to a profile (which may be imported or exported).

FigureC- 19
Intel® HD Graphics
Control Panel -
Profiles

.|
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Display Devices & Options
4

Mini Display Ports

Depending on the port being connected to, external displays can be configured using
either the Intel HD Graphics control panel, Project menu (press the Windows logo
key == on your keyboard and the P key), Display Settings or NVIDIA Control Panel.

4

Attaching Displays

When you first attach an
external display you
may find that the desk-
top does not occupy the

full screen area. Use ei-
ther the display’s auto
adjust/configure  con-
trols, or the Intel(R) HD
Graphics Control Panel
to configure the full
screen display.

Mini Display Port 1 o; If you wish to configure an external display connected to Mini
Display Port 1 you must use Project Menu, Display Settings in Windows (see Figure
C - 2 on page C - 6) or the NVIDIA Control Panel (see “NVIDIA Control Panel” on
page C - 31) to adjust the display configuration.

Mini Display Port 2 @: If you wish to configure an external display connected to Mini
Display Port 2 you must use the Intel HD Graphics control panel menu to control the
display configuration.

Figure C - 20 - Left Side View (Mini Display Ports Highlighted)

C - 26 Display Devices & Options
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Note that you can use external displays connected to the HDMI-Out port and/or ex- "
ternal Mini Display (1.2) ports. Seeyour display device manual to see which formats 7&(

are supported. Devices attached to the Mini Display Port 2 and HDMI port B EnaVi s o el
can be configured in theIntel HD Graphics Control Panel as below. External Displays

Note you may experi-

. . . : . ideo |
Project Menu, Display Settingsin Windows or the NVIDIA Control Panel mﬁ ;Zr;ﬁg \QK‘ZOK Vﬁf

It cannot be configured in the Intel HD Graphics Control Pandl. eos on an attached

Devices attached to the Mini Display Port 1 should be configured using the

4K2K external display.

Intel Display o
Mode Description
Single Display One of the connected displays is used as the display device (PC

screen only or Second screen only).

Clone/Duplicate Both connected displays output the same view and may be configured

independently
Extended / Extend Bot_h connected displays are treated as separate devices, and act as TableC-1

a virtual desktop ;

Display Modes

A number of connected displays are combined into a single C
Collage i . ) .

unified higher resolution for larger screen sizes
Hybrid A number of connected displays are combined and can be

configured in a combination of Clone and Extended modes

.|
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4

Multiple Display

At least one other dis-
play must be attached in
order to view Multiple
Display selection op-
tions.

FigureC- 21
Display > Multiple
Displays (Clone)

Attaching Other Displays

To Clone Displays:

1.
2.

3.
4

5.

Attach your external display to the appropriate port, and turn it on.

Go to the Intel(R) HD Graphics Control Panel control panel and click Display >
Multiple Displays (sub-menu).

Click Clone from the Select Display Mode menu.

Click Apply, and OK to confirm the settings change.

Select the displays from the Select One or More Active Displays menu.

C - 28 Attaching Other Displays
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To Enable Extended Mode:

1. Attach your external display to the appropriate port, and turn it on.

2. Go to the Intel(R) HD Graphics Control Panel control panel and click Display >
Multiple Displays (sub-menu).

3. Click Extended from the Select Display Mode menu.

4. Click Apply, and OK to confirm the settings change.

Click the appropriate monitor icon and drag it to match the physical arrangement you wish
to use (e.g. the secondary display may be extended left/right/above/bel ow the primary dis-

play).

Attaching Other Displays C - 29

4

Display Settings
Extended Desktop

You can have different
Colors, Screen Area
and Monitor Refresh
Rates for each display
device provided your
monitor can support
them.

You can drag the moni-
tor icons to match the
physical layout of your
displays. Icons and pro-
grams may also be
dragged between the

, displays.

FigureC - 22
Display > Multiple
Displays (Extended)
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4

Collage Mode

Collage mode is used to
combine a number of
displays into a single
unified higher resolution
for larger screen sizes,.

FigureC - 23
Display > Multiple
Displays (Collage)

To Enable Collage Mode:

Attach your external display to the appropriate port, and turn it on.

Go to the Intel(R) HD Graphics Control Panel control panel and click Display >
Multiple Displays (sub-menu).

Click Collage from the Select Multiple Display Mode menu.

Click Enable Collage and click On.

Click Vertical or Horizontal to arrange and displays as required.

Click Apply, and OK to confirm the settings change.

C - 30 Attaching Other Displays
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NVIDIA Control Panel

More advanced video configuration options for Mini Display Port 1 are provided
. NVIDIA Control
inthe NVIDIA Control Panel tab.

Panel
1. Gotothe _Control Panel. _ . o T e (G
2. Double-click NVIDIA Control Panel (click to view the control panel in either Large Force..... control panel

icons or Small icons if you are in Category view). from the desktop; right-
click the desktop, then
click NVIDIA Control

Panel.

| C
FigureC- 24 .

NVIDIA Control
Panel

NVIDIA Control Panel C - 31
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The NVIDIA Control Panel provides additional video configuration controls and
A . tools which allow quick access to features such as image settings, 3D Settings and

Navigating the video configuration.

Control Panel

Navigate through the
control panels in much
the same way as you
would a web page.

Click on the sub-head-
ing tasks in the left
menu (and on the high-
lighted links) for infor-
mation. Use the
buttons on the top left
to go back, forward
etc.

FigureC - 25

NVIDIA Control
Panel

. |
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The Help menus provide index and search features, and direct links to the NVIDIA
website etc.

FigureC - 26
Help Menu

NVIDIA Control Panel C - 33
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4

Display GPU
Activity lcon

Click to enable Dis-
play GPU Activity
Icon in the Notifica-
tion Area to quickly
access the GPU Activ-
ity monitor from the
taskbar.

FigureC - 27
NVIDIA Control
Panel - View

Customization Options

One of the most important aspects of hybrid technology isthat it will switch between
theintegrated GPU and discrete GPU seamlessly and automatically, and does not re-
guire any input from the user. However customization options are offered for users
who prefer to set their own parameters for GPU usage.

Context Menu
One of the quickest ways to choose which GPU to use for aparticular applicationis
by using the “Run with graphics processor” in the context menu.

1. Gotothe NVIDIA Control Panel.
2. Click Desktop from the top menu and select Add “Run with graphics
processor” to Context Menu (it should have a check alongside it).

-
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Close the NVIDIA Control Panel.
Find the executable file icon of the application you want to run. 4
Right-click the icon and select Run with graphics processor from the context

MenL. iGPU or dGPU
Select either High-performance NVIDIA processor (dGPU) or Integrated Note the NVIDIA con-
graphics (iGPU) to run the program with the selected GPU. trol panel refers to

High-performance

NVIDIA  processor
(which is the discrete
GPU) and Integrated
graphics (which is the
integrated GPU).

( ) FigureC - 28
Context Menu with
Riaht-click th lication le fil Run with graphics
ight-click the application executablefile processor C
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4

Customization
Options

Although hybrid tech-
nology is completely
seamless to the user,
there are customiza-
tion options within the
control panel (see
page C - 33).

FigureC - 29

Global Settings

Global Settings

Global settings allows you to set the preferred graphics processor for overall use.
Ideally thiswould be theiGPU for battery life, but this can be set to the dGPU if pre-
ferred.

1. Go to the NVIDIA Control Panel.

2. Click Manage 3D Settings (3D Settings) and select Global Settings (tab).

3. Select either Integrated graphics (iGPU) or High performance NVIDIA
Processor (dGPU) from the drop-down menu.

4. Click the Setting menu items to select any options required.

5. Click Apply to save the settings.

-
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Program Settings
Program settings allows you to make specific adjustments for installed applications.

1.
2.
3.

Go to the NVIDIA Control Panel.

Video Driver Controls

Click Manage 3D Settings (3D Settings) and select Program Settings (tab).
Select a program to customize from the drop-down menu, or click Add to add

any program that does not appear in the menu.

Select the preferred graphics processor for the program from the drop-down

menu.
Click the Setting menu items to select any options required.
Click Apply to save the settings.

FigureC- 30
Program Settings
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Configure Surround, PhysXe

NVIDIA® PhysX® isa physics engine that can use the GPU to accel erate game and

3D application performance. Y ou can select the GeForce video card or CPU as a

PhysX® processor, or configure the computer to auto-select a PhysX® processor

(recommended default setting).

1. Go to the NVIDIA Control Panel.

2. Click Configure Surround, PhysX.

3. Click to select a processor from the menu (PhysX Settings); Auto-select
(recommended) is the default setting.

4. Click Apply to save the settings.

FigureC- 31
Configure
Surround, PhysX

.|
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Configuring an External Display (NVIDIA) ~

Note that the NVIDIA Control Panel may only be used to configure external dis- Display Not Shown

plays connected to Mini Display Port 1 (@ Figure1 -9 on page 1 - 17).
If the attached display

Clone the Displays does not appear in the
1. Attach your external display to the appropriate port, and turn it on. “1.Select the displays
2. Goto NVIDIA Control Panel. you want to use.” win-
3. Double-click Display (if the sub-menus are not visible), and then click Set up dow, click “My Display
multiple displays. is not shown..” and
4. Any attached display will appear under “1.Select the displays you want to use.” then click the appropri-
ate button to force de-
tection of the missing
display.
Figure C - 32
Set Up Multiple
Displays

5. Click the check box alongside any display you wish to use.
6. Click Apply > Yes to save any changes made (the Apply button will appear in the
bottom right of the control panel when changes have been made).

.|
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4

Changing the
Primary Display on
Extended Displays

If you want to switch the
primary display if the
displays are extended
then right-click the sec-
ondary display icon and
select “Make Primary”.
Click Apply > Yes to
save the change (see
over).

FigureC - 33

Extend the Display

Extending the Display

1. Attach your external display to the appropriate port, and turn it on.

2. Goto NVIDIA Control Panel.

3. Double-click Display (if the sub-menus are not visible), and then click Set up
multiple displays.

4. Click to select a primary display under “1.Select the displays you want to use.”

5. Right-click the icons under “2.Drag the icons to match....” and select Extend.

Right-click Extend
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The Primary display (the main window display) will be denoted by an asterisk * in
the top right corner of the icon.

To change the Primary display right-click the icon and select Make primary.
Click Apply > Yes to save any changes.

FigureC - 34
Switch Primary
Display

Right-click and select Make primary and click Apply > Yes
to save changes.
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9. You can drag the icons to match the desktop layout you want to use (e.g. you may

want to extend the display to the right or left of the primary display).
10. Click Apply > Yes to save any further changes.

FigureC- 35
Drag Display
Icons

Drag the display icons to match the layout you want to use.
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NVIDIA GeForce Experience -
If you have a working internet connection (and you will need remain connected NVIDIA GeForce
to the internet to run NVIDIA GeForce Experience) you can click the NVIDIA Experience
GeForce Experiencedesktopicon  (or App) to run the application. Thiswill op- Version
timize your gaming settings for your NVIDIA GPU by downloading the latest set-

tings from the NVIDIA cloud data center. Hote that the NVIDIA

GeForce Experience
] ] application is subject
You may need to create an NVIDIA account to log-in to the system (alternatively BEECeREEREREIERG

you may be able to use your Facebook or Google account to log-in). update and revision,
so make sure you con-

nect and update regu-

: ] larly in order to get the
update your settings and check for installed games etc. latest settings and in-

formation.

After logging in to the system you can click through any on-screen instructions to

By running the NVIDI A GeFor ce Experienceyou will be able to download the lat-
est drivers to insure compatibility with games, power saving features and various
other enhancementsfor your NVIDIA GPU (these features are subject to change and
update so check with the NVIDIA website for the latest information).

Note that to enable BatteryBoost you must be connected to the internet.
11.
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Appendix D: Specifications
A

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your distributor/supplier for details.

Note that this computer model series may support a range of CPUs and/or video adapters.

To find out which CPU is installed on your system go to the Start menu and select Settings, and then select System and
click About. This will also provide information on the amount of Installed RAM etc.

To get information on your system’s video adapter go to the Start menu and select Settings, and then select System and
click Display> Advanced display settings > Display adapter properties.
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CPU Speed & Computer in DC Mode

Note that when the computer is in DC mode
(powered by the battery only) the CPU may
not run at full speed. This is a design feature
implemented in order to protect the battery.

Mobile Intel® HM175 Express Chipset

14.0”/ 35.56cm FHD (1920 * 1080), 16:9
(3mm thick) Backlit Panel

Dual Channel DDR4

Two 260 Pins SO-DIMM Sockets
Supporting DDR4 2400 MHz (*Supports
XMP 2666/3000 MHz) Memory Modules
real operational frequency depends on
the FSB of the processor)

Memory Expandable up to 32GB
Compatible with 4GB, 8GB or 16GB Modules

¥
ZAS

SO-DIMM Memory Types

All SO-DIMM memory modules installed in
the system should be identical (the same size
and brand) in order to prevent unexpected
system behavior.

Do not mix SO-DIMM memory module sizes
and brands otherwise unexpected system
problems may occur.

One Changeable 2.5" 7mm (h) Hard Disk
Drive (HDD) / Solid State Drive (SSD)
with SATA (Serial) Interface

One M,2 2280 SSD, SATA or PCle Gen
3*4 Interface - (Factory Option)

High Definition Audio Interface
S/PDIF Digital Output

Built-In Array Microphone

2 * Built-In 2W Speakers

Sound Blaster® X-FI® MB5
ANSP™ 3D Sound Technology on
Headphone Output

External 5.1CH Audio Output (supported
by Headphone, Microphone, & S/PDIF
Jacks)

Built-in Touchpad with Multi-Gesture and
Scrolling Functionality

llluminated White LED A4 Size Keyboard
WASD Gaming Keys

One Type C USB 3.0 (USB 3.1 Gen 1)
OR

One Type C USB 3.1 (USB 3.1 Gen 2)
Port (Factory Option)

*Note: The maximum amount of current supplied
by USB Type-C ports is 500 mA for USB2.0/900
mA for USB 3.1

Three USB 3.0 Ports (USB 3.1 Gen 1,
including 1 AC/DC Powered USB Port)
One HDMI-Out (High-Definition
Multimedia Interface) Port (with HDCP)
One Mini DisplayPort 1.2

One Mini DisplayPort 1.4 Ready)

One Headphone-Out Jack
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One Microphone-In Jack
One S/PDIF Out Jack
One RJ-45 LAN Jack
One DC-In Jack

Embedded Multi-In-1 Card Reader

- MMC/ RS MMC

- SD/ Mini SD / SDHC/ SDXC

Note: Some of these cards require PC
adapters usually supplied with the cards.

Three M.2 Card Slots:

Slot 1 for M.2 2230 WLAN Combo Module
with PCle & USB Interfaces (A Key)

Slot 2 for M.2 2280 SSD (Solid State
Drive) Card with SATA / PCle Gen 3*4
Interface (M Key)

Slot 3 for M.2 3042 LTE/UTMS/HSPA+ 3G
or 4G Module with USB Interface (B Key)
(Factory Option)

Built-In 10/100/1000Mb Base-TX
Ethernet LAN

2.0M FHD PC Video Camera Module

Intel® Dual Band Wireless-AC 8265
(2*2 802.11 a/lc) M.2 WLAN + Bluetooth
Combo M.2 2230 Module (Factory Option)

Intel® Dual Band Wireless-AC 3168 (1*1
802.11 ac) WLAN + Bluetooth Combo M.2
2230 Module (Factory Option)

Qualcomm® Atheros Killer™ Wireless-
AC 1535 Dual Band (2*2 802.11 ac)
WLAN + Bluetooth 4.1 Combo M.2 1630
Module (Factory Option)

3G UTMS/HSPA+ M.2 3042 Card Module
(Factory Option) OR 4G LTE M.2 3042
Card Module (Factory Option)

*Note that UMTS modes CAN NOT be used in
North America

Full Range AC/DC Adapter — AC in 100 -
240V, 50 - 60Hz DC Output 19.5V, 6.15A
(120 Watts)

Embedded 3 Cell Polymer Battery Pack
45WH

Specifications

Supports Wake on LAN (AC Mode Only)
Supports Wake on USB

Supports Wake on RTC Alarm (AC Mode
Only)

LED Indicators - Power/Suspend,
Battery, HDD, Airplane Mode, Camera

64Mb SPI Flash ROM
AMI BIOS

Windows® 10 (64-bit)

Security (Kensington® Type) Lock Slot
BIOS Password

Trusted Platform Module 2.0 (Factory
Option)

Intel® PTT for systems without TPM
hardware
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All Alloy Style

Shipping Mode

FlexiCharger

Microsoft Cortana with Voice Technology
Intel® Optane™

Temperature

Operating: 5°C - 35°C
Non-Operating: -20°C - 60°C
Relative Humidity

Operating: 20% - 80%
Non-Operating: 10% - 90%

349mm(w) * 247mm(d) * 25.4mm(h)
2.0kg *Barebone System with 45WH
Battery

*A barebone system does not include the HDD,
RAM, adapter, power cord and factory option
modules (weight tolerance within +/- 5%).
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